This is a Service Pack for version UniLogic 1.30 Rev52 and UniStream OS1.30.31 released in September 2020

**Bug Fixes**

These bugs are fixed in this service pack:

- PTO sometimes functioned incorrectly
- VNC Server:
  - Using a direct contact element for the "General.VNC Touched Bit" would cause a compilation error
  - Checking the "App resolution" checkbox would cause the "With cursor" and "Set 'Touch bit'" checkboxes to be disabled
- Library, C functions: importing a C function from the Library would cause UniLogic to delete the code from other C functions in the project

**Improvements**

- Trends:
  - Trend widget loads faster
- Now supports axis values
- Global tag import: now includes a 'Cancel' import option
- REST API:
  - if the Base URL is invalid, UniLogic now gives a compilation error
  - REST API compilation errors now allow you to click in the error list directly to the error location

*Change Summaries for Previous Versions* begin on the following page.
Unitronics Fall 2020 release launches a new member of the UniStream series: a UniStream Built-in controller with a big 10.1" panel offering 1024 x 600 (WSVGA) resolution.

As a PLC + HMI + I/O, UniStream 10.1 is available in a broad range of expandable, built-in I/O configurations, and is available in Standard (B5) and Pro (B10) models. Both models support advanced communications, including MQTT, VNC, FTP, SNMP, email and SMS messaging. The Pro version also offers built-in Webserver, video support and SQL.

UniStream Built-in benefits include auto-tuned PID, data logging, data tables and recipes, data sampling displayed via built-in Trends and Gauges, Alarms, multi-level passwords, portrait mode, and plug & play communications for CANopen, CAN Layer2, MODBUS, EtherNet/IP, Servo made Simple, and more.

Other release features include support for:

- New USL external VNC display panels for UniStream: ‘big-screen’ USL 15.6" & USL 10.1"
- REST API
- PTO, via I/O Module UID-0808THS

**New Hardware**

NEW

**UniStream Built-in 10.1**

With a big, 10.1" Panel offering 1024 x 600 (WSVGA) resolution, UniStream 10.1 is available in a broad range of expandable, built-in I/O configurations - available in Standard (B5) & Pro (B10) models.

Both versions support advanced communications including MQTT, VNC, FTP, SNMP, email and SMS messaging. The Pro version also offers built-in Webserver, video support and SQL.

UniStream’s built-in benefits include auto-tuned PID, data logging, data tables and recipes, data sampling displayed via built-in Trends and Gauges, Alarms, multi-level passwords, portrait mode, and plug & play communications for CANopen, CAN Layer2, MODBUS, EtherNet/IP, Servo made Simple, and more.
### Models

<table>
<thead>
<tr>
<th>Models</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>US10-B5-B1</td>
<td>No built-in I/Os</td>
</tr>
<tr>
<td>US10-B10-B1</td>
<td>No built-in I/Os</td>
</tr>
<tr>
<td>US10-B5-TR22</td>
<td>10 Digital, 2 Analog Inputs, 2 Transistor outputs, npn, including 2 PWM outputs.</td>
</tr>
<tr>
<td>US10-B10-TR22</td>
<td>8 Relay outputs</td>
</tr>
<tr>
<td>US10-B5-T24</td>
<td>10 Digital, 2 Analog Inputs, 12 Transistor outputs, pnp, including 2 PWM</td>
</tr>
<tr>
<td>US10-B10-T24</td>
<td>8 Relay outputs</td>
</tr>
<tr>
<td>US10-B5-RA28</td>
<td>14 Digital, including 2 HSC, 2 Analog Inputs, 2 Temperature inputs,</td>
</tr>
<tr>
<td>US10-B10-RA28</td>
<td>8 Relay outputs, 2 Analog outputs</td>
</tr>
<tr>
<td>US10-B5-TA30</td>
<td>14 Digital inputs, including 2 HSC, 2 Analog inputs, 2 Temperature inputs,</td>
</tr>
<tr>
<td>US10-B10-TA30</td>
<td>10 Transistor outputs, pnp, including 2 PWM, 2 Analog outputs</td>
</tr>
<tr>
<td>US10-B5-R38</td>
<td>24 Digital inputs, including 4 HSC, 12 relay outputs</td>
</tr>
<tr>
<td>US10-B10-R38</td>
<td>14 Digital inputs, including 4 HSC, 2 Analog inputs, 16 Transistor outputs,</td>
</tr>
<tr>
<td>US10-B5-T42</td>
<td>12 relay outputs</td>
</tr>
<tr>
<td>US10-B10-T42</td>
<td>16 Transistor outputs, pnp, including 2 PWM</td>
</tr>
</tbody>
</table>

### NEW USL Displays

Big-screen UniStream USL Displays 10.4” and 15.6” are, included in this release.

UniStream Displays are a series of color touch-screens that support VNC.
A UniStream controller can operate as a REST API client and can request specific data from a server. In order to communicate with an API REST server, you build a request, comprising Query and Response Parameters.

PTO

You can now implement Pulse Train Output (PTO) via the high-speed outputs of I/O Module UID-0808THS.

Using PTO you can, for example, build Motion/Speed profiles that are appropriate for stepper motors.

New Time-savers:

Development Mode & Quick Sync

Development Mode and Quick Sync are time-saving features that can help you to develop UniLogic projects more efficiently. You can use them independently, or both together.

- **Development Mode**: when enabled, this mode saves time by temporarily suspending, for 1 hour, the password verification process performed between UniLogic and UniStream at download.
- **Quick Sync**: downloads small changes in Ladder, Message Composer, Switch Case, and Formula, while other changes are ignored. This can save significant download time during project development.

UAC: New Features

The new UAC features listed below are useful for all, but are especially needed for UAC projects supporting the standard CFR-21 part 11:

**UAC User Groups, new Password features:**
- **Expired On**: Password ageing, the number of days a password will be in effect for a member of a group before it expires.
- **Lockout Timeout**: Determines the number of minutes the user will be locked out before being allowed to attempt to log in.
- **Login Attempts**: The number of Login attempts a member of a group may attempt to login before being locked out.
- **Alarm Status Viewer widget**: If you enable UAC, you can select if buttons--ACK, CLR, Disable and Shelve Alarm--will be visible to a specific User Group.

**Additional features**
- **HMI Trends**:
  - When a Trend graph is displayed, you can now press a new button in the top left corner to hide the buttons and increase the viewing space, and press again to display them.
  - Trend properties now include an option to change the background color of the Curve text (the default is black)
- **Via UniApps, you can now enable UniStream to register when a connected VNC client screen is touched**. In UniApps, access the Network tab-> VNC Server, check the Set 'touch bit' and press apply. The VNC server will restart with the VNC "touch" identification option enabled.
- **USB Action Files**: you can now include a PLC Password, selecting either to retain the default password, or overwrite the current password with a value that you provide.
- **Modems**: when you add a modem, you can now add a Signal Quality Refresh Rate.
- **Message Composer**: now supports REAL tags.

**Bugs fixed in this version**
These have been fixed in the current version:
- **MQTT**  Minor bug fixes
- **Modem / SMS / Email**: emails were received from certain servers without a 'From' header.
- **USL**: sometimes was is disabled in UniApps.
- **UAC**: Users could log in, although another user was already logged in; a notification will now pop-up requesting logout.
- **Ethernet/IP** In certain circumstances, EDS import would fail.
- **HMI keyboard**: in Portrait view, the alphanumeric keyboard was missing the Z character.
- **UniApps**: Project Export to USB stick did not request a password.
Unitronics Spring 2020 release introduces brand new hardware and powerful new software features to broaden your project potential!

**New Hardware**

- New Ethernet-based URB components:
  - I/O modules: Loadcell/Strain-gauge, PWM, and Pulse I/O modules
  - I/O adapter: URB-TCP2, a compact, competitively-priced adapter that supports up to 6 URB I/O modules.

- Introducing Unitronics 4G Routers! Our new 4G/LTE & WiFi cellular Routers support embedded SMS functionality, RS232, RS485, GNSS (GPS), microSD, USB interface, and on-board Digital & Analog I/Os.

**New Software**

- BACnet IP Server: Yes, UniStream controllers as BACnet IP Servers! The broad range of Services, Objects, and Tasks enables you to blaze new ground in Building Automation and Environmental Control. Compatible with all UniStream controllers. We invite you to activate the trial license to check it out!

- High-priority Ladder Task + Immediate Ladder Functions: *Supported by the following models: US5/7-B5/10-T42 and USC-B5/10-T42. *

- Motion Control: - Update Firmware Wizard: | New Motion Control Functions: Apply Torque / Apply Force | New Actuators: Rack & Pinion, Roll-feeder / Conveyor | - Upload Axis Parameters to PC


- Authentication New!: Embedded user authentication now requires a PLC password before executing commands and tasks; simply install this UniLogic version, upgrade UniStream firmware--and gain increased security.

Regarding Authentication: Unitronics tracks the dynamic challenges that cybersecurity present to industrial automation. This version requires users to enter a PLC password before executing commands and tasks. UniLogic includes a default password. **Please change the default password** to minimize exposure to un-authorized cyber users.

We highly recommend you take this opportunity to benefit from the increased security offered in this version release. To do so, you must update your UniLogic software, upgrade UniStream firmware, and download an application created/updated in this current version.
Read on to learn of other exciting features in this release, including new servo Motion Control functions, new Actuators, and more!

### Spring 2020 Feature List

#### NEW in Remote URB I/O

Hardware Configuration now offers new additions to our line of URB Ethernet-based Remote I/O:
- Compact I/O Adapter URB-TCP2, which can support up to 6 URB I/O modules
- New I/O modules, including Loadcell/Strain-gauge and PWM modules

<table>
<thead>
<tr>
<th>Model</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>URS-02LC-8</td>
<td>Load Cell</td>
</tr>
<tr>
<td>URD-04PW</td>
<td>PWM, 4 Channels</td>
</tr>
<tr>
<td>URD-02PW</td>
<td>PWM, 2 Channels</td>
</tr>
<tr>
<td>URD-02PU</td>
<td>Pulse2 Channels</td>
</tr>
<tr>
<td>URA-0800T</td>
<td>8 Analog Inputs, Current</td>
</tr>
<tr>
<td>URA-0800U</td>
<td>8 Analog Inputs, Voltage</td>
</tr>
<tr>
<td>URA-0008Y</td>
<td>8 Analog Outputs, Current</td>
</tr>
<tr>
<td>URA-0008Z</td>
<td>8 Analog Outputs, Voltage</td>
</tr>
</tbody>
</table>
Routers

Unitronics new 4G cellular routers enable you to send and receive SMS messages via Ethernet. Hardware Configuration now offers these models:

- **UCR-ST-B5**
  4G/LTE & WiFi cellular router with 2 Ethernet ports and I/O

- **UCR-ST-B8**
  Dual-SIM 4G/LTE & WiFi cellular router with 4 Ethernet ports, Digital & Analogue I/Os, RS232, RS485, GNSS (GPS), microSD, and USB interface
BACnet Server

A UniStream controller can now act as a BACnet Server, supporting a range of Services, Objects, and Tasks.

Note that BACnet Server requires a license purchase, available from your Unitronics’ sales representative.

Unitronics offers you a One-hour Trial Offer, in order to enable you to explore this new exciting feature. Note that each time you power up your controller, you can restart the One-hour Trial Offer.

To learn how to activate the Trial Offer, refer to the BACnet Server topic in the UniLogic Help.

Ladder: High-priority Ladder tasks (Interrupts)

A High-priority Ladder task runs independently of your Ladder program according to a specific time interval. Use them with Ladder functions Immediate Read Input/Input, Immediate Set/Reset Output.

These features are only visible in UniLogic when you select supporting models in Hardware Configuration, such as the US5/7-B5x-T42 and USC-B5/10-T42; when unsupported models are selected, these features are hidden.
Authentication: UniLogic to UniStream

Starting with this UniLogic version and the accompanying UniStream firmware, Unitronics embedded user authentication measures into both UniLogic software and UniStream firmware. This enables you to prevent unauthorized access to your UniStream controller.

For this reason, UniLogic requires users to enter a PLC password before executing commands and tasks that require UniLogic to UniStream communication.

The first time a user establishes UniLogic to UniStream communications to a particular PLC, for example at application download, or to run online Test mode, UniLogic prompts the user to change the default UniStream access password.

For details, including how to restore the default password, refer to the Help topic Authentication: UniLogic to UniStream.

Motion Control

Update Firmware Wizard

This version offers several new Motion Control features, plus a new Servo Firmware Update wizard.

You can easily update your Unitronics' UMD Servo firmware via the Wizard, now available on the Servo Drives ribbon tab.

New Motion Control Functions

The Ladder Toolbox offers two new MC functions:

- **MC Apply Torque**
  Enables you to set Torque and apply it according to the physical values you define in the Axis Configuration, regardless of the motor specification.

- **MC Apply Force**
  Enables you to set Force and apply it according to the physical values you define in the Axis Configuration, regardless of the motor specification (linear actuators only).

In addition, MC Move Relative and MC Move Additive now support Continuous Update; set a bit to evaluate input parameters at each cycle.
**New Actuators**

Two new actuators are available: Rack & Pinion, and Roll-feeder / Conveyor, allowing you to convert rotary movement to linear values.

**Upload Axis Parameters to PC**

When you configure an axis, the values you enter in the Axis Struct are written to the axis at power-up. When you enter values from the HMI, the axis functions according to these values, but the values you have entered will be overwritten at power-up.

To overwrite the values in the axis struct, use Upload Parameters in PC.
**Additional Motion features**

Axis Interface: Automatic conversion and rounding in Actuator properties. When you change the Unit setting, UniLogic now converts the value; for example, if Unit was set to μm and the value was 1000, setting the units to mm converts the value to 10.

Custom Units: You can now select Custom Units when working with linear actuators.

**EtherNetIP: NEW EDS Features**

You can now:
- Import a manufacturer's EDS configuration, when you set UniStream to act as a scanner.
- Create and export an EDS file for adapter nodes you define in UniLogic.
Additional Features

**MODBUS**
- New Operations: MODBUS command **0x17 Write/Read Multiple Registers** - Periodic and Aperiodic.
  
  These operations perform a combination of one Read operation and one Write operation in a single MODBUS transaction.
  
  - You can now export and import a UniStream MODBUS Master's slave definitions, via a proprietary Unitronics file.
  - You can now assign a MODBUS slave a Unit ID of 0

**CANbus**
- The addition of a CANbus "Sniffer Filter" can help you monitor--and debug--only the specific CANbus units you specify, according to ID. Note that this can be helpful in Servo applications.

**MQTT**
- You can now assign a machine identifier to an MQTT topic: `{PLC.MAC},{PLC.SN},{PLC.NAME}`; PLC Names are assigned in UniApps.
- The user name in MQTT Broker Connection has been increased to 128 characters.

**VNC Server**
- Now supports 1024x768 resolution

**OPC UA**
- You now have the option to import client certificate files.

**Alarms**
- You can now Export/Import Alarm groups
- At reboot, the Alarm Summary is now retained

**UAC**
- New option - numeric keypad instead of alpha numeric

**DT widget**
- You can now display the Descriptions of array members; formerly you could only display the index number

**RTC Time zone**
- Now supports partial hours.

**Schedule HMI**
- Times can now be entered in 12h format (AM and PM)

**Emails**
- The email TLS version was upgraded to TLS1.2

**FTP**
- Limit the access to FTP to specific folder
Bugs fixed in this version

These have been fixed in the current version:

- Data Sampler History file: in certain situations, Force Sample did not function correctly.
- UniCAN Communication: When CAN cable was disconnected and reconnected, or CAN power cycled, Tx between UniStream and V1040 would fail
- Initial values of retained tags: Sometimes did not update in PLC after regular Download
- Web Trend: Curve Names in Legend, were not visible when the Plot was set to white Fill
- Alarm Summary\Banner: When the alarm name contained the characters " ' " the alarm did not display in Alarm Summary\Banner
- SQL Query: Using a constant with parameters that included non-English caused a 'CPU Error'.
- UID-0200E and UID-0200D: Configuration sometimes did not download to PLC.
- Web Server: State machine button would show a false positive compile error when linked to a numeric tag that was not INT16
- 'MQTT Send Aperiodic': when sending values that were stored on the same Ladder net, would send old values
- email: email with data sample attached as csv.zip, could not be sent
- Store DTI to File: If Append + only CSV options was selected, no file would be generated
- Modem Init Ladder function: In certain cases the function returned Success, when using a modem without a SIM
- USBF: Could not write retained tags to the file
- URS-04RT: Would use a UINT16 instead of an INT16, which does not provide for negative temperatures. To fix existing projects, the I/O module needs to be removed from Hardware Configuration and re-added.
- Alarm file: not all Alarms were saved after after reboot
- MQTT: Cannot connect to Broker with a tag bigger than 1kb
- Message Composer:
  -CRC was not calculated correctly in specific numeric values
  -sometimes failed to build a message if it included a UINT32 value
This is a Service Pack version, UniLogic 1.28.34, OS 1.28.58. This service pack is for the previous UniLogic version 1.28.26 and OS 1.28.39 released in September.

This version includes the features and bug fixes listed below.

Features

- The Receive buffer size has been increased to 4K RX, enabling larger messages to be received via the Rx COM port.

- UniApps now offers an Ignore Uni IO Popup button, located in UniApps under System-> System Logs.

- Store UDTF to File:
  - Using this function to append data requires a UDTF file. Therefore, if in parameter E, you select option 1, Append to File, you must select either options 1 or 2 to create a UDTF file in parameter F. If you select, selected either options 2 or 3 (create .csv only or create .csv.zip only), the status parameter will indicate -14: append UDTF file error
  - In addition, there is now a new status indication -8: signature file error

Bug fixes - fixed in this service pack

- UniCAN connection between UniStream and EX-RC/RC1: in certain cases, the connection was not re-established after disconnection.

- Ethernet/IP scanner: in some cases, the Ethernet/IP scanner was not able to re-establish connection with the adapter.

- Trend Widget History Button, HMI & Web: the button was greyed out and disabled in the previous version.

- Email: csv.zip Data Sample attachments could not be sent.

- System -> RTC Date -> Day of the week: when the day of the week was set to Saturday, the tag value did not update to 7.

- Mail Configurator Widget: under certain circumstances, selecting To/Cc/Bcc caused an HMI Application Overload.

- HMI:
  - Numeric box: at times, UniLogic did not allow the user to link an array member to a numeric box.
  - Custom controls: UniLogic displayed these on a black background, appearing blurred, instead of being transparent.

- AutoStart: in certain cases, the system did not recover from a crash, if a defined CANbus node was not found.

- Multi-Touch keyboard: in certain cases, the Virtual keyboard of multi-touch models did not respond.
Unitronics fall release for 2019 launches a major addition to our All-in-One Solution: Motion Control. Our full range of Servos and Motors is easily programmed in UniLogic; the Ladder editor offers PLCopen-compliant MC Function Blocks. In addition, Unitronics supplies you with Ready-made Motion code; this enables you to immediately get moving with your Motion system.

UniLogic greatly simplifies servo applications by enabling you to:

- Drag & drop drives and motors into your project: UniLogic automatically defines the correct configuration and automatically sets up communications for you
- Add up to 8 Axes, drag & drop actuators; UniLogic automatically converts units
- Benefit from automatic calculations: UniLogic analyzes the mechanical properties of your selections and recommends safe values
- Use the Ready-made Motion application to execute movements, such as Point-to-Point, Jog, and Homing—you can open this application and edit as needed to adapt it to your motion requirements
- Program Motion Control via drag & drop, using industry standard motion Function Blocks (PLCopen)
- Tune your system using a single parameter
- Diagnostics: View servo run-time performance via UniLogic’s built-in powerful, high-speed scope
Another major feature of this release is **OPC UA** - UniStream controllers can now act as OPC UA servers.

This release also includes additional features.

**Feature List**

**Motion**

Hardware Configuration now offers Servo Drives and Motors.

In addition:
- The Ladder editor offers COM: Servo functions, and PLCopen-compliant MC Function Blocks
- Unitronics supplies you with Ready-made Motion code; this enables you to immediately get moving with your Motion system.

**OPC UA**

UniStream controllers can now function as OPC UA servers.

**Digital Signature**

The Data Table files generated by the function Data Table: Indexed> Store DTI to File are now automatically stamped with a digital signature.

**Ladder: Draw**

New Ladder Functions enable you to draw shapes, and groups of shapes on the HMI screen (Not yet documented)

**RTC/GMT**

UniStream now supports two clocks, Local Time and GMT. You can use these in Ladder elements, HMI Widgets, and set them via UniApps.
- A new parameter has been added to the RTC struct, Time Zone
- Existing Ladder functions Set PLC Time/Date now have a new parameter, Status.
- New System structs have been added, UTC Time and UTC Date

**Additional features**

- IO bus system struct now includes a tag: IO Boot Reset
- Web Data Table element now includes Show Last Update
- Web Data Table width limit reduced to 300px
- Caption of the table in Data Tables widgets (HMI/Web)
- SQL now includes Test Connection
- CANopen: CANopen nodes can now be duplicated
- HMI:
  - Message Boxes can now be aligned
  - Message Box Buttons: location can be changed
  - HMI Slider: ticks color may be changed
  - HMI Trends: Background Color, Grid Color and Plot Color can now be changed
Alarms offer new options:
- Alarms Silent ACK
- hide the Snooze button
- display the alarm banner only if there's an alarm

CRC ladder element: new CRC_ASCII option

User Access Control, User options, now has two new options:
- Show User Name; un-check to hide a user's name in the Scroller at login
- Allow Change Password, un-check to hide that option from the user

Store DTI To file, new options:
- 0 - No CSV File (Only udtf)
- 1 - Create CSV File (ALL udtf/csv/csv.zip)
- 2 - Only csv
- 3 - Only csv.zip

SD Management now includes Data Table files

The following passwords now support up to 16 characters:
- UniApps Administrator
- UniApps Guest
- Upload
- Import/Export App

Project Level Actions: Now includes Safely remove SD and Safely remove DOK (memory stick)

String tags have been increased to 256 characters

Online mode view: maximum tag size increased from 256 bytes to 514.

**Bugs fixed in this version**

- In certain cases, the Web tables index column ("#") would sometimes present only zeros.
- Using */ in region or rung comments would cause compilation errors.
- If the project was created when the UniLogic UI language was set to Chinese or Czech, SD Management did not work.
- Web-Server - HyperLink did not work when linked to a Const string tag
- While linking an array to FB in Ladder, when selecting the array with the mouse cursor, the keyboard input did not function
- If the user selected URB modules before selecting a power supply, the modules did not function correctly.
Hardware Configuration

UniStream PLC  Hardware Configuration now offers UniStream PLC +I/Os controllers.

The series is available in three versions: Pro, Standard, and Basic.

Note that a model number that includes:

- B10 refers to Pro version (e.g. USC-B10-T24)
- B5 refers to Standard version (e.g. USC-B5-RA28)
- B3 refers to Basic version (e.g. USC-B3-T20)

Features

Power Features
- Built-in Trends and Gauges, auto-tuned PID, data tables, data sampling, and Recipes
- UniApps™: Access & edit data, monitor, troubleshoot & debug and more
- Security: Multi-level password protection
- Alarms: Built-in system, ANSI/ISA standards

I/O Options
- Built-in I/O configuration, varies according to model
- Local I/O expansion via Uni-I/O™ modules, and UAG-XKxxxx I/O expansion adapters
- UniStream Remote I/O Ethernet adapters and modules

COM Options
- Built-in ports: 2 Ethernet, 1 USB host, 1 USB device port
- Add-on ports (UAC-CB), available by separate order:
  - 1 CANbus port may be added to all models
  - RS232/485 ports: according to model technical specifications

COM Protocols
- Fieldbus: CANopen, CAN Layer2, MODBUS, EtherNet/IP and more. Implement any serial RS232/485, TCP/IP, or CANbus third-party protocols via Message Composer
- Advanced: SNMP Agent/Trap, e-mail, SMS, modems, GPRS/GSM, VNC Client, FTP Server/Client
- Remote Access via any device that supports VNC
Programming Software
All-in-One software for hardware configuration, communications, and HMI /PLC applications, available as a free download from Unitronics.

HMI
All UniStream PLCs can display HMI screens on the following devices:
- UniStream Display (USL)
- UniStream Modular HMI panel (USP)
- UniStream Built-in (on the panels integral to the device)
- Any device screen that supports VNC client
HMI screens are designed in UniLogic. In addition to the HMI screens, UniStream PLCs offer built-in HMI features, including:
- UniApps™: Access & edit data, monitor, troubleshoot, debug, and more
- Security: Multi-level password protection
- Alarms: Built-in system, ANSI/ISA standards

<table>
<thead>
<tr>
<th>Differences between B10, B5, and B3</th>
<th>Feature</th>
<th>B10 Pro</th>
<th>B5 Standard</th>
<th>B3 Basic</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Expansion via Uni-I/O</td>
<td>Yes</td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Remote I/O Expansion via Ethernet I/O Adapter (URB)</td>
<td>Up to 8</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VFD</td>
<td>32</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MicroSD</td>
<td>Yes</td>
<td>No*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add-on COM modules</td>
<td>3</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Memory</td>
<td>6GB</td>
<td>3GB</td>
<td>3GB</td>
<td></td>
</tr>
<tr>
<td>MODBUS Slaves</td>
<td>Unlimited</td>
<td>Up to 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethernet/IP Scanners</td>
<td>16</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethernet/IP Adapters</td>
<td>32</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Server</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>SQL Client</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>MQTT</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PID Loops</td>
<td>64</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Sampler/Trends</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSV files: creating/ reading</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FTP, server/client</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Saving Data Tables to SD</td>
<td>Yes</td>
<td>No*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screenshots</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sending email attachments</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB device (programming port)</td>
<td>Yes</td>
<td>No**</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Note that B3 models do not support features requiring SD cards. In addition, Alarm History is not retained after PLC reset.

** Note that B3 models may be programmed only via Ethernet cable.
### UniStream PLC Models

The built-in I/O configurations are indicated by the last group of digits in the model number. For example, **USC-B5-TR22** and **USC-B10-TR22** have identical I/O configurations.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>USC-B5-B1</td>
<td>These models do not have built-in I/Os.</td>
<td></td>
</tr>
<tr>
<td>USC-B10-B1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B5-TR22</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B10-TR22</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B5-T24</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B10-T24</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B5-RA28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B10-RA28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B5-TA30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B10-TA30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B5-R38</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B10-R38</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B5-T42</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B10-T42</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B3-R20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USC-B3-T20</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**USC-B5-B1**

**USC-B10-B1**

- 10 Digital inputs, 24VDC, sink/source
- 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits
- 2 Transistor outputs, nnp, including 2 High speed PWM output channels
- 8 Relay outputs

**USC-B5-TR22**

**USC-B10-TR22**

- 10 Digital inputs, 24VDC, sink/source
- 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits
- 2 Transistor outputs, nnp, including 2 High speed PWM output channels
- 8 Relay outputs

**USC-B5-T24**

**USC-B10-T24**

- 10 Digital inputs, 24VDC, sink/source
- 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits
- 10 Transistor outputs, pnp, including 2 PWM output channels

**USC-B5-RA28**

**USC-B10-RA28**

- 14 Digital inputs, 24VDC, sink/source, including 2 High speed counter input channels
- 2 Analog inputs, 0÷10V / 0÷20mA, 14 bits
- 2 Temperature inputs, RTD / Thermocouple
- 8 Relay outputs
- 2 Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits

**USC-B5-TA30**

**USC-B10-TA30**

- 14x Digital inputs, 24VDC, sink/source, including 2 High speed counter input channels
- 2 x Analog inputs, 0÷10V / 0÷20mA, 14 bits
- 2 x Temperature inputs, RTD / Thermocouple
- 10 x Transistor outputs, pnp, including 2 PWM output channels
- 2 x Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits

**USC-B5-R38**

**USC-B10-R38**

- 24x Digital inputs, 24VDC, sink/source, including 4 High speed counter input channels
- 2 x Analog inputs, 0÷10V / 0÷20mA, 12 bits
- 12 Relay outputs

**USC-B5-T42**

**USC-B10-T42**

- 24x Digital inputs, 24VDC, sink/source, including 4 High speed counter input channels
- 2 x Analog inputs, 0÷10V / 0÷20mA, 12 bits
- 2x Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits
- 16x Transistor outputs, source (pnp), including 2 PWM output channels

**USC-B3-R20**

- 10 Digital Inputs
- 2 Analog Inputs
- 8 Relay Outputs

**USC-B3-T20**

- 10 Digital inputs,
- 2 Analog Inputs, 8 Transistor Outputs, pnp, including2 PWM Outputs
This is a special UniStream PLC feature; it enables the user to carry out certain tasks without the need to interact with the PLC via an HMI panel.

Programmers can create Action files in UniLogic and save them to a USB mass storage device, such as a flash drive. The end user can plug the drive into the PLC’s USB port, and then press the Confirm button on the front of the PLC to run the file and execute the Actions.

Actions include updating firmware and network settings, downloading applications, extracting log files, and more. In order for Actions to execute, the PLC must have permission. USB Action Permissions are set in Hardware Co, and are written to the PLC at download.

- Set Permissions
- Create Action Files
Hardware Configuration now shows over 20 new UniStream Remote I/O modules.

<table>
<thead>
<tr>
<th><strong>Digital Inputs</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URD-1600-8</td>
<td>16 Digital Inputs (Sink / Source), 24VDC</td>
</tr>
<tr>
<td>URD-3200-4</td>
<td>32 Digital Inputs (Sink / Source), 24VDC</td>
</tr>
<tr>
<td>URD-0400B</td>
<td>4 Digital Inputs, 120VAC</td>
</tr>
<tr>
<td>URD-0400C</td>
<td>4 Digital Inputs, 240VAC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Encoder / High Speed Counters</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URD-0200E</td>
<td>2 High Speed Counters / Encoder Inputs, 24VDC</td>
</tr>
<tr>
<td>URD-0200D</td>
<td>2 High Speed Counters / Encoder Inputs, 5VDC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Digital Outputs</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URD-0008CI</td>
<td>8 Digital Outputs, (Source), 24VDC/2A</td>
</tr>
<tr>
<td>URD-0016CG-8</td>
<td>16 Digital Outputs, (Source), 24VDC/0.3A</td>
</tr>
<tr>
<td>URD-0032CG-4</td>
<td>32 Digital Outputs, (Source), 24VDC/0.3A</td>
</tr>
<tr>
<td>URD-0008NI</td>
<td>8 Digital Outputs, (Sink), 24VDC/2A</td>
</tr>
<tr>
<td>URD-0016NG-8</td>
<td>16 Digital Outputs, (Sink), 24VDC/0.3A</td>
</tr>
<tr>
<td>URD-0032NG-4</td>
<td>32 Digital Outputs, (Sink), 24VDC/0.3A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Relay</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URD-0004SK</td>
<td>4 Solid State Relay, 240VAC/DC, 0.5A</td>
</tr>
<tr>
<td>URD-0004SM</td>
<td>4 Solid State Relay, 110VAC/DC, 1A</td>
</tr>
<tr>
<td>URD-0004SN</td>
<td>4 Solid State Relay, 24VAC/DC, 2A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Analog Inputs 12 bit</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URA-1600O-8</td>
<td>16 Analog Current Inputs 12bit</td>
</tr>
<tr>
<td>URA-1600P-8</td>
<td>16 Analog Voltage Inputs 12bit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Analog Inputs 16 bit</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URA-1600T-8</td>
<td>16 Analog Current Inputs 16bit</td>
</tr>
<tr>
<td>URA-1600U-8</td>
<td>16 Analog Voltage Inputs 16bit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Analog Outputs 12 bit</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URA-0004X</td>
<td>4 Analog Voltage Outputs 12bit</td>
</tr>
<tr>
<td>URA-0016X-8</td>
<td>16 Analog Voltage Outputs 12bit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Analog Outputs 16 bit</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URA-0016Z-8</td>
<td>16 Analog Voltage Outputs 16bit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Temperature</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>URS-04RT</td>
<td>4 RTD / Resistance</td>
</tr>
<tr>
<td>URS-04TC</td>
<td>4 Thermocouple / mV</td>
</tr>
<tr>
<td>URS-08RT-2</td>
<td>8 RTD / Resistance</td>
</tr>
<tr>
<td>URS-08TC-2</td>
<td>8 Thermocouple / mV</td>
</tr>
</tbody>
</table>
HART Support: New Uni-I/O

The new UNI-I/O model **UIA-0800NH**, offers 8 analog channels with HART communication.

UAG-CX-XKPLXXXX

UniStream CX Long-range I/O expansion adapter + embedded Power Supply for UniStream controllers offering jacks, such as the UniStream Built-in series. Available in lengths of 600, 1200, 1500, 2000, 3000 cm.

Additional Features

Set PLC Configuration from file

A new Ladder function enables you to load configuration files that modify the parameters shown below.

<table>
<thead>
<tr>
<th>Function</th>
<th>Editable Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Accounts</td>
<td>User Name, Password, Outgoing Server Settings, From</td>
</tr>
<tr>
<td>FTP Client</td>
<td>User Name, Password, Port, Remote IP</td>
</tr>
<tr>
<td>FTP Server</td>
<td>User Name, Password, Port, Read Only</td>
</tr>
<tr>
<td>FTP RAM Server</td>
<td>User Name, Password, Port</td>
</tr>
<tr>
<td>Panel: Network</td>
<td>IP Address, Subnet Mask, Default Gateway</td>
</tr>
<tr>
<td>COM Modbus</td>
<td>Baud Rate, Data Bit, Parity Bit, Stop Bit</td>
</tr>
<tr>
<td>COM txrx/com</td>
<td></td>
</tr>
</tbody>
</table>

Switch Case

You can define groups of Switch Cases, and then run them via the Switch Case Ladder function.

This enables you to run multiple Compare operations in a single case, and use the results to drive one or more events.
When you run a stored procedure, you can ignore @ placeholders by checking the "Is Executing a stored procedure" checkbox for each query.
email Attachment, Alarm Logs
You can now attach Alarm Logs as a .csv file.

New Ladder Elements
- Zip File from SD: Locate a file in an SD folder, zip it in .zip or gz format, and place it in a destination folder on the SD.
- FTP Compare File: locate a file on a remote FTP Server, compare it to a file on the controller's SD card, and overwrite the SD file if it is different.

HMI Editor Additions
- HMI PDF Viewer element: now offers Indirect file name support
- UniLogic HMI Toolbox: sort custom controls according to ABC
- Password box and Text Box HMI: now includes Numeric keypad support.

Alarms
Alarms now support several new features:
- Global actions:
  - Create/close and Zip Alarm log
  - Clear all Alarms
  - Clear and Ack all Alarms
- Each individual Alarm now includes:
  - Alarm Cleared bit
  - Alarm Suppression bit
- New HMI Actions:
  - Clear all Alarms
  - Clear and Ack all Alarms
- New Alarm Ladder Elements:
  - Modify Alarm texts from CSV file
  - Reset cleared Alarm state

Default Language: Korean
You can now, when selecting a controller, under Properties/Regional Settings, select Korean, causing the controller to display the Korean keyboard when a user needs to enter data via the HMI screen.

Modbus
Modbus Groups have been increased to up to 128 groups

Bugs fixed in this version
- RTC Date/Time is now editable while in "Online" mode
- Web Server: State Machine buttons are now visible as expected
- Web Server: Web Page Roles can now be duplicated
- Online mode: Would sometimes disconnect randomly
- Table Recipe: If the name of the linked struct was changed, the table values would not be visible
- UniLogic gives compilation error if an SQL query includes an alias name
- Duplicating an array inside a struct would not keep members’ names and comments
- Changing member of array name as Function In sometimes changed the current view
This is a Service Pack version, UniLogic 1.25.61, OS 1.25.38. This service pack is for the previous UniLogic version 1.25 Rev56 released in October.

It includes the bug fixes listed below.

- **Web Server**: Toggle Bit did not work
- **URB Remote I/O**: occasionally raised compilation errors, although functionality was not affected
- **MQTT**:
  - Tags were sometimes registered incorrectly
  - Could not connect to an AWS broker via self-certificate
  - Long fields sometimes failed to publish data in JSON format

---

### UniLogic V1.25 Rev56 UniStream OS 1.25

**Important!**
The recent Microsoft Windows release has required a UniLogic compatibility update. To avoid errors, it is highly recommended to update your previous UniLogic installations to this version, 1.25.56.

---

This UniLogic service pack includes important compatibility updates that comply with the recent release of Microsoft Windows. UniLogic version 1.25.56 replaces UniLogic 1.25.54, which was released on October 17, 2018.

Please note that the UniStream OS version released on October 17, 1.25.36, is unchanged, and does not need to be updated.

In addition, this Service Pack includes the bug fixes listed below.

- **Bugs fixed in this Service Pack**
  - Major Windows compatibility update
  - **Undo**: In certain cases, using Undo in Ladder caused crashes.
  - **HMI/Webpage editor**: Auto-complete did not recognize struct members if the struct contained a buffer.
  - **Project conversion**: In certain cases, RS485 communications were not correctly converted when converting from UniStream Built-in to Modular
- Web Trends:
  - Curves names including an apostrophe caused errors.
  - Y-axis tick labels were incorrectly rounded.
  - Excel Export: Tag names, alias names or comments beginning with = prevent could not be exported.
  - Function/HMI Screen export: in certain cases, the exported file corrupted
UniLogic V1.25 Rev54 UniStream OS 1.25.38, November 12 2018

This version of UniLogic supports two new product lines: all-new UniStream® Remote I/Os and UniStream® Built-in 7” - a new addition to the UniStream controller family.

UniStream Remote I/O comprises an Ethernet-based Remote I/O adapter and I/O Remote modules. A single UniStream Remote I/O adapter can support up to 63 12mm-wide I/O modules. Each adapter comprises two Ethernet ports; this enables users to link an adapter to a controller, and then daisy-chain adapters to support up to 8 adapters per controller, increasing the total number of I/Os supported by a single UniStream.

The new line offers a broad range of modules; each module offers a different configuration of analog and digital outputs. To learn more about UniStream I/O options, please click here.

Compact, connected and Industry 4.0 ready, new UniStream® 7” Built-in All-in-One controller brings you the advanced communication capabilities you need for Industry 4, complete control functionality.

The new All-in-One controller is available in two series: UniStream 7” Built-in and UniStream 7” Built-in Pro. Both series support MQTT, SNMP, VNC, FTP, SMS, email, and communications via GSM/GPRS modem.

The Pro version also offers a built-in Webserver, audio jack, and video support, as well as SQL, a plus for system integrators and OEMs facing Industry 4.0. To learn more, please click here.

Read on to learn more about these and other new version features.

---

**UniStream Remote I/O**

Hardware Configuration now includes new UniStream Remote I/Os. Simply drag & drop an adapter into the configuration, and add your desired modules.

---

**UniStream Built-in 7”**

Hardware Configuration offers these UniStream Built-in 7” models listed below.
Hardware Activation registers a UniStream controller and any connected Uni-I/O modules with Unitronics. During the activation process, the serial numbers of the controller and any physically connected Uni-I/O modules are sent to Unitronics, along with the activation date.

The process is carried out automatically by UniLogic when you download an application from UniLogic, if the Uni-I/O in the application matches the Uni-I/O modules physically connected to the controller.

In cases where you download the application via USB (memory stick), you can voluntarily carry out Hardware Activation via alternative methods; details regarding these methods are given in the document located here.

VFD

Additional models are now supported in Hardware Configuration.

MQTT

Broker Encryption now supports Self-signed Certificates.

Web Server

The web server now supports indirect images.

- Bugs fixed in this version
  - Firmware Upgrade: Would not work if the PLC was installed with Firmware 1.18.x or older
  - Web Server: Trend name was not displayed

<table>
<thead>
<tr>
<th>Model</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>US7-B5-B1</td>
<td>These models do not have built-in I/Os.</td>
</tr>
<tr>
<td>US7-B10-B1</td>
<td></td>
</tr>
<tr>
<td>US7-B5-TR22</td>
<td></td>
</tr>
<tr>
<td>US7-B10-TR22</td>
<td>• 10 Digital inputs, 24VDC, sink/source</td>
</tr>
<tr>
<td></td>
<td>• 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits</td>
</tr>
<tr>
<td></td>
<td>• 2 Transistor outputs, npn, including 2 High speed PWM output channels</td>
</tr>
<tr>
<td></td>
<td>• 8 Relay outputs</td>
</tr>
<tr>
<td>US7-B5-T24</td>
<td></td>
</tr>
<tr>
<td>US7-B10-T24</td>
<td>• 10 Digital inputs, 24VDC, sink/source</td>
</tr>
<tr>
<td></td>
<td>• 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits</td>
</tr>
<tr>
<td></td>
<td>• 12 Transistor outputs, npn, including 2 PFM output channels</td>
</tr>
<tr>
<td>US7-B5-RA28</td>
<td></td>
</tr>
<tr>
<td>US7-B10-RA28</td>
<td>• 14 Digital inputs, 24VDC, sink/source, including 2 High speed counter input channels</td>
</tr>
<tr>
<td></td>
<td>• 2 Analog inputs, 0÷10V / 0÷20mA, 14 bits</td>
</tr>
<tr>
<td></td>
<td>• 2 Temperature inputs, RTD / Thermocouple</td>
</tr>
<tr>
<td></td>
<td>• 8 Relay outputs</td>
</tr>
<tr>
<td></td>
<td>• 2 Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits</td>
</tr>
<tr>
<td>US7-B5-TA30</td>
<td></td>
</tr>
<tr>
<td>US7-B10-TA30</td>
<td>• 14x Digital inputs, 24VDC, sink/source, including 2 High speed counter input channels</td>
</tr>
<tr>
<td></td>
<td>• 2 x Analog inputs, 0÷10V / 0÷20mA, 14 bits</td>
</tr>
<tr>
<td></td>
<td>• 2 x Temperature inputs, RTD / Thermocouple</td>
</tr>
<tr>
<td></td>
<td>• 10 x Transistor outputs, npn, including 2 PFM output channels</td>
</tr>
<tr>
<td></td>
<td>• 2 x Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits</td>
</tr>
<tr>
<td>US7-B5-R38</td>
<td></td>
</tr>
<tr>
<td>US7-B10-R38</td>
<td>• 24x Digital inputs, 24VDC, sink/source, including 4 High speed counter input channels</td>
</tr>
<tr>
<td></td>
<td>• 2 x Analog inputs, 0÷10V / 0÷20mA, 12 bits</td>
</tr>
<tr>
<td></td>
<td>• 12 Relay outputs</td>
</tr>
<tr>
<td>US7-B5-T42</td>
<td></td>
</tr>
<tr>
<td>US7-B10-T42</td>
<td>• 24x Digital inputs, 24VDC, sink/source, including 4 High speed counter input channels</td>
</tr>
<tr>
<td></td>
<td>• 2 x Analog inputs, 0÷10V / 0÷20mA, 12 bits</td>
</tr>
<tr>
<td></td>
<td>• 2x Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits</td>
</tr>
<tr>
<td></td>
<td>• 16x Transistor outputs, source (npn), including 2 PFM output channels</td>
</tr>
</tbody>
</table>
- Data Tables: When pasting data or importing data from CSV, empty lines would be ignored, and UniLogic might crash
- IP Address: Edit boxes did not update Panel IP Settings if one was changed to a non-matching value
- Radio Button: the 'when selected' option was set to 1
- MQTT: Application stopped when broker was disconnected
- SQL: Query status was stuck on 'in progress' after running a SELECT query with more than 62 columns
- System bit "External Storage.Is SD Present" was set to 1 after disconnecting SD card
UniLogic V1.24.56 UniStream OS 1.24.21 July 30 2018

Release Features

**VFDs, Variable Frequency Drives**

Unitronics’ new line of VFDs is available in Single Phase and Three Phase input. The list of VFDs may be found on the Unitronics website.

Configuration via UniLogic’s Hardware Configuration is via simple selection; adding a VFD creates a VFD file comprising a configuration file, VFD parameters and commands.

<table>
<thead>
<tr>
<th>Function Code</th>
<th>Name</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>P00.00</td>
<td>Speed control mode</td>
<td>Sensorless</td>
</tr>
<tr>
<td>P00.01</td>
<td>Run command channel</td>
<td>Keypad run</td>
</tr>
<tr>
<td>P00.03</td>
<td>Max output frequency</td>
<td>55.00</td>
</tr>
<tr>
<td>P00.04</td>
<td>Upper limit of the running frequency</td>
<td>54.00</td>
</tr>
<tr>
<td>P00.05</td>
<td>Lower limit of the running frequency</td>
<td>0.00</td>
</tr>
<tr>
<td>P00.11</td>
<td>ACC time 1</td>
<td>100</td>
</tr>
<tr>
<td>P00.12</td>
<td>DEC time 1</td>
<td>100</td>
</tr>
<tr>
<td>P00.13</td>
<td>Running direction selection</td>
<td>Runs at the</td>
</tr>
<tr>
<td>P02.01</td>
<td>Asynchronous motor 1 rated power</td>
<td>1.5</td>
</tr>
</tbody>
</table>

UniLogic also creates a struct; you can use these tags to manage the VFD via Ladder, or in your HMI application. In addition to remotely accessing your VFD via UniLogic, you can also use another new feature described below, Online Test Mode’s Scope Trace to debug it.

<table>
<thead>
<tr>
<th>New Online Test Mode: Scope Trace</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scope Trace</strong> enables you to select tags, and view the running values as a graph in Online Test Mode. You can:</td>
</tr>
<tr>
<td>- Select curves / deselect curves</td>
</tr>
<tr>
<td>- Hide all curves but selected one</td>
</tr>
<tr>
<td>- Hide Y axis.</td>
</tr>
<tr>
<td>- Zoom in / Zoom out for X axis.</td>
</tr>
<tr>
<td>- Zoom in / Zoom out for Y axis</td>
</tr>
</tbody>
</table>
You can also use the View buttons to open the running Scope Trace, View History, or open saved .ulg sample files.
UniStream 5” Portrait Mode

UniStream 5” controllers now offer a new setting: Panel Orientation. You can now select to present your HMI display in either Landscape or the new Portrait mode.

New Scenario: Measure Time

UID-0808THS and UID-0808T I/O modules offer a new scenario, Measure Time, which allows you to measure the time elapsed between the changing state of two inputs.

```
UID-0808THS 0 I/O HS Block 1
```

<table>
<thead>
<tr>
<th>Property</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-Speed Type</td>
<td>Measure Time between 2 inputs</td>
</tr>
<tr>
<td>Trigger on input 1</td>
<td>Rise</td>
</tr>
<tr>
<td>Trigger on input 2</td>
<td>Rise</td>
</tr>
<tr>
<td>Use Module Filter</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Exponential Notation

Web and HMI Numeric boxes now offer Exponential Notation (read-only).

Bugs fixed in this version

- The bit “External Storage.Is SD Present” was sometimes ON, after ejecting SD card.
- VFD Manager: a memory leak issue has been fixed.

VFD models added

- UMI-0007EU-B1
- UMI-0015EU-B1
- UMI-0022EU-B1

- Renaming errors: in certain cases, renaming Data Samplers, SMS, or emails in the Solution Explorer caused a compilation error.
- Modbus TCP: certain applications containing very large numbers MODBUS TCP Remote slaves suffered communication failures.
- Web Page Editor: Copying or duplicating a web page with a hyperlink did not retain the "Open in new window" checkbox value.
- Web Server modules names beginning with a digit caused a PLC web server error.
- In certain cases, Counter and Scenario 2 did not function as expected.
UNILOGIC® V 1.23 REV25 UNISTREAM® OS 1.23.8 February 2018

Release Features

MQTT

MQTT runs over TCP/IP, with a publish - subscribe structure.

- A Publisher sends messages according to Topics, to specified Brokers.
- A Broker acts as a switchboard, accepting messages from publishers on specified topics, and sending them to subscribers to those topics.
- A Subscriber receives messages from connected Brokers and specified Topics.

UniStream supports MQTT as a 'client' that can both publish, and subscribe, to messages. UniStream can:

- Publish data:
  - To a defined Broker according to a configured Topic. For example, the Topic may be Kiln; the messages can include application data such as temperature or pressure.
  - Periodically, according to a time period set in the configuration
  - Aperiodically, via Ladder Function

- Receive data from a defined Broker on a defined Topic, to which UniStream is subscribed.

New UniStream 5" Models in Hardware Configuration

Hardware Configuration now includes four new models of the UniStream 5" series - PLC + HMI + I/O all built into a single, powerful controller.

Each model offers a unique, built-in I/O configuration.

<table>
<thead>
<tr>
<th>Model</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>US5-B5-R38</td>
<td>24 Digital inputs, 24VDC, sink/source, including 4 High speed counter input channels</td>
</tr>
<tr>
<td>US5-B5-R38</td>
<td>2 Analog inputs, 0÷10V / 0÷20mA, 12 bits</td>
</tr>
<tr>
<td>US5-B5-R38</td>
<td>12 Relay outputs</td>
</tr>
<tr>
<td>US5-B5-T42</td>
<td>24 Digital inputs, 24VDC, sink/source, including 4 High speed counter input channels</td>
</tr>
<tr>
<td>US5-B5-T42</td>
<td>2 Analog inputs, 0÷10V / 0÷20mA, 12 bits</td>
</tr>
<tr>
<td>US5-B5-T42</td>
<td>2 Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits</td>
</tr>
<tr>
<td>US5-B5-T42</td>
<td>16 Transistor outputs, pnp, including 2 High speed PWM output channels</td>
</tr>
</tbody>
</table>

Superbly compact, these programmable controllers are available in two versions: UniStream 5" and UniStream 5" Pro. Note that model numbers including:

- **B5** refer to standard UniStream 5" (e.g. US5-B5-R38 )
- **B10** refer to UniStream 5" Pro (e.g. US5-B10-R38 )

B10 Pro models support all standard UniStream features, including COM Protocols. The differences between B5 and B10 are listed in the accompanying table.

<table>
<thead>
<tr>
<th>Feature</th>
<th>B5</th>
<th>B10 (Pro)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Jack</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Video/RSTP Support</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Web Server</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>SQL Client</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Additional Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HID Device Support</strong></td>
<td>HMI panel USB COM ports now support HID devices, such as scanners.</td>
</tr>
<tr>
<td><strong>SQL: PostgreSQL</strong></td>
<td>SQL Connector now supports PostgreSQL databases in addition to SQL Server and MySQL.</td>
</tr>
<tr>
<td><strong>HMI Editor Additions</strong></td>
<td>HMI editing is easier than ever before with these new features:</td>
</tr>
<tr>
<td></td>
<td>- Lock the location of individual elements</td>
</tr>
<tr>
<td></td>
<td>- Group HMI Elements: either select via mouse-drag, or hold down your keyboard CTRL key and click the desired elements</td>
</tr>
<tr>
<td></td>
<td>- Assign HMI Elements to Layers</td>
</tr>
<tr>
<td><strong>Virtual Keyboards</strong></td>
<td>UniStream now supports the Korean keyboard.</td>
</tr>
<tr>
<td></td>
<td>In addition, the Swedish keyboard has been improved; the virtual keys characters have been reordered to reflect common standards.</td>
</tr>
<tr>
<td><strong>UniApps: Languages</strong></td>
<td>UniApps has been localized to two new languages:</td>
</tr>
<tr>
<td></td>
<td>- Korean</td>
</tr>
<tr>
<td></td>
<td>- Italian</td>
</tr>
<tr>
<td><strong>C Editor</strong></td>
<td>UniLogic's C Editor has been updated, making C programming even friendlier than before, with color-added coding support.</td>
</tr>
<tr>
<td><strong>SMS Variables</strong></td>
<td>SMS messaging now supports a new String Variable, enabling you to send ASCII strings in your SMS messages.</td>
</tr>
<tr>
<td><strong>Online Test Mode</strong></td>
<td>Color selection on Online power-flow (Red, Green, Blue, Yellow, and Darker Yellow).</td>
</tr>
<tr>
<td><strong>Structs</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Duplication: You can now right click a member of a struct, and select Duplicate Member.</td>
</tr>
<tr>
<td></td>
<td>- Struct Definitions to/from Excel: the PLC tab on the UniLogic ribbon now includes Export and Export Structs.</td>
</tr>
<tr>
<td><strong>Export/Import</strong></td>
<td>Export / Import of Functions, Screen, Web pages etc. has been improved. (It now takes about 1/3 of previous time).</td>
</tr>
<tr>
<td><strong>Ethernet/IP</strong></td>
<td>The maximum scanner / vendor tag size limit has been increased from 496 to 505 bytes.</td>
</tr>
<tr>
<td><strong>New System Tags</strong></td>
<td>These system structs contain new tags:</td>
</tr>
<tr>
<td></td>
<td>- External Storage &gt; Is SD Locked?</td>
</tr>
<tr>
<td></td>
<td>The status of this bit shows the SD state: 0=SD Unlocked, 1- SD Locked</td>
</tr>
<tr>
<td></td>
<td>- Panel Events&gt; Video Complete</td>
</tr>
<tr>
<td></td>
<td>This tag turns ON when a video finishes playing. It must be reset by the user</td>
</tr>
<tr>
<td><strong>DTI strings</strong></td>
<td>DTI Strings can now be aligned to the left.</td>
</tr>
</tbody>
</table>

**Bugs fixed in this version**
- FTP server: In certain cases, UniStream could not connect to server.
- SQL Connector: including a REAL data type tag caused SQL Connector to remain "In progress"
- Ladder Function CSV to UDFT: In certain cases, linking a REAL data type tag to a column caused the function to remain "In progress"
- Converting HMI screen to Web page: did not support underscore or certain other characters
- Web Server: Trends, Tanks, and Meter (inner range) did not display correctly if the given range was in Hex
- Web Server: Elements did not always support exponential notation
- Web Server & HMI List of Texts: Did not always scroll correctly
- Data Tag Editing: Typing an Alias name directly into the grid did not support spaces
- HMI Multi-line TextBox: Did not display multi-line text if set to read-only
- Undo: UniLogic sometimes failed to execute undo
- UniApps UAC: Adding more than 16 users from UniApps in UAC would cause an error
- MODBUS RTU RS485: Marking a MODBUS Struct as Retained caused a Compilation error

**UNILOGIC V 1.22 REV13 UNISTREAM OS 1.22.9 December 2017**

This version features two new UniStream 5” model in Hardware Configuration. The US5-Bx-TA30 offers an excellent built-in I/O configuration, including:

- 14 x Digital inputs, 24VDC, sink/source, including 2 High speed counter input channels
- 2 x Analog inputs, 0÷10V / 0÷20mA, 14 bits
- 2 x Temperature inputs, RTD / Thermocouple
- 10 x Transistor outputs, pnp, including 2 PWM output channels
- 2 x Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits

Other features in this release include:

- Support for a new modem, the SIMCOM T5320A.
- In UniLogic, when you add a new functions, HMI screen, or webpage, the focus will be on the name, in the Solution Explorer
- UniApps & Pop-ups now offer French
- You can now find HMI and Web elements that are used in your project by right-clicking them and selecting Find from the right-click menu.
- The Upgrade Firmware process has been improved, and is more robust
- Email:
  - Sender’s name can now contain spaces
  - Account passwords: now support special characters

**Bug List: Fixed in this version**

- In certain cases, if a Data Table was used by both HMI and Web, the Data Table did not load on the Web Server
- US5-RA28:
  - Occasionally, resetting this model while initializing Retained tags would cause a CPU error
  - High speed input: after changing counter direction 3 times, resetting counter did not reset it to zero
- Windows 10: Fit To Optimal Size did not always work as expected after changing font size on HMI or Web elements
- Web Server: at times, the Circular or Linear gauge would render incorrectly or would give compilation errors about gauge size being too small.
• In certain circumstances, deleting a user-defined struct or an array in a user-defined struct deleted the members of a different array, leaving the array with no members.
• Occasionally, a serial port struct was duplicated.
• In CANOpen EDS Configuration, INT32 is mapped into a UINT32
• Renaming an array that contains members with Alias names would sometimes cause the aliases to be deleted from memory.
• The bit "External Storage.Is SD Present" was sometimes ON, after uninstalling the SD card
• Initialize Retained Tags from UniLogic did not work on UniStream 7, 10, 15” models
• Email subject line would show Kanji characters instead of Icelandic/Hebrew
• XY Trend: Date is wrong after downloading project
• RTSP: Disconnecting the camera while the video widget was on-screen caused 'HMI Overload' error

UNILOGIC V1.21 REV51 UNISTREAM OS 1.21.12, September 2017

Hardware Configuration

UniStream 5” Hardware Configuration now offers the UniStream 5” PLC+HMI+I/Os All-in-One programmable controllers comprising built-in PLC, HMI panel, and built-in I/Os.

The series is available in two versions: UniStream 5” and UniStream 5” Pro:
• B5 refers to standard UniStream 5” (e.g. US5-B5-TR22)
• B10 refers to UniStream 5” Pro (e.g. US5-B10-TR22)
**Features**

**HMI**
- Resistive Color Touch-screens
- Rich graphic library for HMI design

**Power Features**
- Built-in Trends and Gauges, auto-tuned PID, data tables, data sampling, and Recipes
- UniApps™: Access & edit data, monitor, troubleshoot & debug and more – via HMI or remotely via VNC
- Security: Multi-level password protection
- Alarms: Built-in system, ANSI/ISA standards

**I/O Options**
- Built-in I/O configuration, varies according to model
- Local I/O via UAG-CX series I/O expansion adapters and standard UniStream Uni-I/O™ modules
- Remote I/O via EX-RC1

**COM Options**
- Built-in ports: 1 Ethernet, 1 USB host, 1 Mini-B USB device port
- Serial and CANbus ports may be added via UAC-CX modules

**COM Protocols**
- Fieldbus: CANopen, CAN Layer2, MODBUS, EtherNetIP and more.
  Implement any serial RS232/485, TCP/IP, or CANbus third-party protocols via Message Composer
- Advanced: SNMP Agent/Trap, e-mail, SMS, modems, GPRS/GSM, VNC Client, FTP Server/Client

**Programming Software**
- All-in-One software for hardware configuration, communications, and HMI/PLC applications, available as a free download from Unitronics.

**Differences between B5 and B10**

<table>
<thead>
<tr>
<th>Feature</th>
<th>B5</th>
<th>B10 (Pro)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Jack</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Video/RSTP Support</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Web Server</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>SQL Client</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The built-in I/O configurations are indicated by the last group of digits in the model number. For example, US5-B5-TR22 and US5-B10-TR22 have identical I/O configurations.

**US5-B5-B1**
- These models do not have built-in I/Os. I/Os can be added via UAG-CX adapters as described above.

**US5-B5-T24**
- 10 Digital inputs, 24VDC, sink/source
- 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits
- 2 Transistor outputs, npn, including 2 High speed PWM output channels
- 8 Relay outputs

**US5-B10-TR22**
- 10 Digital inputs, 24VDC, sink/source
- 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits
- 2 Transistor outputs, npn, including 2 PWM output channels

**US5-B5-T24**
- 10 Digital inputs, 24VDC, sink/source
- 2 Analog inputs, 0÷10V / 0÷20mA, 12 bits
- 10 Transistor outputs, pnp, including 2 PWM output channels

**US5-B10-RA28**
- 14 Digital inputs, 24VDC, sink/source, including 2 High speed counter input channels
- 2 Analog inputs, 0÷10V / 0÷20mA, 14 bits
- 2 Temperature inputs, RTD / Thermocouple
- 8 Relay outputs
- 2 Analog outputs, 0÷10V / -10÷10V / 0÷20mA / 4÷20mA, 12 bits
UniStream 5” CX Modules

A new line of I/O adapters and COM modules, the CX series, has been created. These are compatible with the UniStream 5”:

- UAG-CX-xxx I/O Expansion Adapters plug into the UniStream 5” I/O Expansion Jack, and enables you to link standard Uni-I/O modules to the controller. Installation instructions and guidelines on installation and number of supported I/O modules are in the product’s Installation guides and technical specifications.
- Three UAC-CX-xxx COM Modules are now available:
  - UAC-CX-01RS2 offers one RS232 port
  - UAC-CX-01RS4 offers one RS485 port
  - UAC-CX-01CAN offers one CANbus port.
  Installation instructions and further information are in the product’s Installation guides and technical specifications.

Hardware Configuration: New Design

Hardware Configuration has been completely redesigned, to allow for the new UniStream 5 series.

Note that the controller you select modifies the option that UniLogic presents for I/O and COM modules, and shows only the options that are relevant for your selected controller.
**Additional Features and Improvements**

**SD Card Management**  
Via SD Management, you can limit the number of files; when the limit you define for a specific file type is exceeded, the controller will automatically delete 1/8 of the oldest files for that feature.

![SD Management](image)

**UAC: Management Level**  
Management Level enables you to set the ability of group members to edit the properties of other members. Members of the New Super Group level can edit any and all properties of Users or Groups in UniApps, including the properties of other Super Group members. This can be very helpful in cases where Admin passwords have been forgotten.

![User Access Control](image)

**Data Table Values**  
Three new features have been added:

- **Read/Write Data Tables values To/From**  
  Link to your PLC, and then click the appropriate button.

- **Export/Import range**  
  Drag your cursor across the desired cells to highlight them, and then click the appropriate button.

- **Copy to Clipboard**  
  You can now highlight a range of cells, and use Ctrl +C to copy the values to Windows Clipboard.

Note that as of this version, you must double-click a cell in order to view the values. This was done to enable you to click once in a cell, and drag your mouse to highlight a range.
Passwords: Import Export via UniApps
When you import or export an application via System>User App Upgrade>, you can now include the VNC passwords.

VNC Password
You can now choose whether or not to enable a VNC server Password.

RTSP Camera
Previously, the RSTP camera url was limited to 50 characters; this has now been increased to 128 characters.

Windows Explorer: Tooltips
The tooltip over a project file now shows the UniLogic version that the project was last saved in (If the information is available. If not, the version appears as Unknown).

When right clicking a project file and selecting “Properties”, you will get the file properties window with an extra tab called UniLogic project file.
If the project was last saved in UniLogic 1.21 and up, the extra information about PLC Mode, Creation and saved date (and by whom), and number of functions and screens will have valid data.
Notes Regarding this Version

<table>
<thead>
<tr>
<th>Registration</th>
<th>Beginning with this version, please note that user registration is required. It is a simple process that takes only a few minutes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>XP/Vista Support</td>
<td>As of this version, UniLogic will not support Windows XP or Vista.</td>
</tr>
</tbody>
</table>

Bug List: Fixed in 1.20

- Test Mode in UDFBs: in some cases, running online Test Mode in UDFBs caused a CPU error.
- Upload to PC: the PLC retained memory was not always uploaded to PC.
- File Selector: Double-clicking a directory sometimes caused an application crash.

UniLogic V1.19.83 UniStream OS 1.19.83 May 2017

Top Features:

- New UniStream USP-104-M10 offers the first integrated Multi-Touch panel, enabling gestures such as swipe, double-tap, press & tap, and more, including Two-Hand operation – a recognized safety measure
- CANopen: EDS Import, View, Edit, and new EDS Ladder Functions
- UDFB Online: view running values within UDFBs, including local tags.
- Powerful MODBUS features: Aperiodic via Ladder, Add Aperiodic/ Periodic Operations per slave, singly or in batches
- Receive SMS: new Ladder Element, plus an option for Authorized Numbers
- Support for MYSQL, plus communication options: via Port or Instance Name

Hardware Configuration

New UniStream: Multi-Touch panel

Hardware Configuration now offers the USP-104M10 PLC. This multi-touch model offers new gesture options such as Swipe for screen navigation, and enables you to trigger actions via Press, Long Press, Press & Tap, double-tap and more.
A single screen can contain elements configured to different triggers. This enables you to add a layer of safety to your screens. For example, you can implement a 2-point press (two-handed operation) that requires the user to press the screen in two distinct locations to activate a task.

**Communications**

**CANopen: EDS Import, View, Edit**

You can now easily import, view, and edit EDS files for CANopen devices, as well as automatically create PDO structs.

**New EDS Ladder functions**

EDS functions enable you to initialize the device with values currently in the EDS file, including values that you edit/enter via...
UniLogic's EDS utility. In your program, use the In Progress bits to condition the functions.

**Init Node EDS**: Initialize a specific node with values edited/entered via the EDS utility.

**Init All Nodes EDS**: Initialize all of the CANopen nodes in your project.

**Restore Node Defaults**: If your CANopen device enables this function, which refers to object 1011 in the node's dictionary, you can use this to reset all of the node's addresses to the manufacturer's default values.

Heartbeat

Enabling Heartbeat allows a heartbeat from the PLC according to the time interval specified in the parameter Heartbeat time. The time range is 100 (default) to 100000ms (10 seconds).

**CANopen CPU Stop Mode**

Switching to Stop Mode will automatically send a reset command to all nodes.

**MODBUS Added Features:**

This version offers the ability to create both Periodic and Aperiodic operations, either one at a time or in batches.

**Aperiodic via Ladder, Operation Batches**

Most application requirements are met by Periodic operations, which run according to the time intervals you set. However, you now have greater flexibility to:

- Use simple Periodic Operations to read/write data from/to many sensors,
- Use an Aperiodic Operation to write a single setpoint as the result of a run-time condition,
- Use an Aperiodic Operation to turn a group of outputs ON as the result of a run-time condition.

Note that you can prevent an individual operation from running via a bit in the operation's Active parameter.
Two new MODBUS Ladder Elements, Aperiodic InDirect and Aperiodic InDirect Group to enable you to trigger a single operation, or a group of operations, via your application.

Troubleshooting MODBUS

You now have new MODBUS troubleshooting options:

- A new parameter in the Remote Slave’s struct, Drops can help you to troubleshoot projects with a large number of sensors, where the entire queue of operations may not be able to run during the scan.
- A Status field has been added to the MODBUS operation Parameters. This will hold the error codes from the MODBUS protocol itself. Note that it must be reset in your application.

SMS: Receive SMS + Authorize Numbers

Use this new Ladder element to receive an SMS message and store it along with its metadata.

You can also block messages from unauthorized numbers by creating an Authorized Numbers list in Modem Configuration.
MYSQL Support: via Port

If you select SQL Server, you can now select to use either Instance Name, or Port.

Message Composer

Float values are now supported.

EthernetIP

The Scanner Node struct now contains the parameter Connection status. This contains the response status of the connection attempt.

HMI & Web

Data Table Widget

This version brings added widget features. You can now:

- Assign Column Width/Visibility to each individual widget
- Move the focus and highlight a specific row in a data table by writing a value to the property Tag: Selected Row Index
- When a data table is displayed, touch anywhere within a row to select that row
- If you assign a Float value to a column, you can determine the location of the decimal point via by right-clicking the column and assigning it
HMI and Webpage Editor Redesign

Both editors have been redesigned for faster, smoother function, and load screens - even screens with many elements - faster than before.

Other added features include "Snap" behavior:

Rotation: While rotating, elements will now automatically snap to angles of 90-180° when approaching these angles. To rotate without snapping, first hold down the Alt button on your keypad, then click and begin the rotation.

Alignment: Now, the active element is marked by handles. When moving elements, a snap to middle line is displayed.

HMI: FTP Image Widget

Use this widget to stream files from an IP camera that uploads images to an FTP server. The images are cached in a folder on the SD card. Buttons the user to display images, clear the image cache, or to save the images currently being displayed.
**HMI: Live Trend Widget**

New [Live Trend](#) displays a running variable integer value as a curve on a Trend graph. You may define up to 4 curves. Unlike Trends derived from Data Sampling:

- Live Trend values are not drawn from a Data Sampler.
- Live Trends do not store any values, log any data, or create any files.

They are convenient for tasks such as representing temperature values, where only monitoring is needed and logging is not required.

When the Live Trend runs, pressing Inspect displays sampling points.

You can touch a point to view its value.

---

**Web: State Machine Button**

[State Machine](#) Button is now available for Web pages as well as HMI display; use the value of a register to display variable text within a button, and to drive multiple Actions via the button.
**HMI Element:** Password  
A new attribute, Password Length, allows you to enter a number to limit the number of characters, 1-32, that the user can type into the field.

**Asian Language Support**  
UniStream now supports the WenQuanYi Zen Hei font which supports Chinese, simplified/traditional, and also Korean.

**HMI Elements:** Digital Schedule & Digital Time  
When checked, a new attribute, Retain AM/PM Space, retains the Placeholder space for AM/PM when H24 (24-hour format) is selected.

**Usability Boosters**

**UDFBs: Online Values**  
View online/debug values within UDFBs, including local tags, along with a counter 'since last update': simply right-click the Call UDFB function in the Ladder, and select Monitor.
A new, easy way to assign tags is via CTRL + Drag & Drop.
Press and hold down the CTRL keyboard key, click a tag, and then drag and drop it to assign a ladder parameter or an HMI option. You can drag tags from the tag database window, or a tag assigned as a ladder parameter or HMI option.

You can now drag any Formula directly from the Solution Explorer, instead of placing a Formula Ladder element via the Ladder Toolbox and linking it to a Formula.

If you download the same project into UniStream, and are connected to the unit, Online mode now begins automatically.

The Ladder ribbon tab contains two new icons: that enable you to find rungs that are disabled, as well as rungs marked "ToDo:".

To mark a rung, enter the text "ToDo:" including the colon. (the text itself is not case-sensitive).
Additional Features and Improvements

### Alarms: Ack via Ladder
This Ladder element, located in the Ladder toolbox under Alarms, enables you to acknowledge a single alarm, group of alarms, or all of the unacknowledged alarms in the system via Ladder.

![Ladder screenshot](image)

### New Actions: Screenshot, Load VNC
New [Project-Level Actions](#) enable you to Turn a bit ON to:
- Take a screenshot of the current HMI screen.
- Load the VNC Client.
  - This is helpful when using a UniStream as a remote panel for another UniStream controller.

### Online mode: Easier editing
Editing tags in debug mode no longer opens a separate window; editing is now done directly, and shows both the new, edited value and the former, current value.

### Excel Import to Data Tables
You can now select the number of rows you wish to import, when the Data Table contains only strings.

### Signature Log
The Project signature, which you can view by selecting the Tools> Signature icon on the UniLogic ribbon, now offers Creation Date and Upgrades.

### Timers: Current Value
The parameter Current Value in the Timer’s struct is now writable.

---

**Bug List: Fixed in current version V1.19 Rev83**

- Due to the addition in V19.18.80 of UDFB online Test Mode, Ladder Functions that used many tags (local & global) together with nesting of Ladder functions calls occasionally caused a CPU error
- UniLogic sometimes crashed if CANOpen Node ID was changed, then an EDS was loaded, and then Create PDO Struct was selected
- Modbus max queue size fixed
- HMI (And Web Server)- mouse-over elements did not display tooltip
- Lock HMI screen did not work
UniLogic crashed if a constant tag was used in the EDS
Replacing a bit used by Positive/Negative contacts/coils elements occasionally caused a compilation error
RTSP URL field was limited to 50 characters, now allows 128
Output window appeared empty (The text was white)
The notifier crashed when iterating a crashed project with files with access denied.
TPDO and RPDO numbers were not updated in node’s struct when structs were generated from EDS
COB-ID could not be a fixed number.
Tooltips were added to CANOpen
Order of tags in the locals grid was incorrect.
Changed UniLogic manifest from highest Available to require Administrator

**Bug List: Fixed in Version V1.19 Rev80**

- In certain circumstances, UDP broadcast did not function.
- HMI Password box: was formerly limited to 8 characters. The programmer may now set attribute from 1 to 32.
- HMI File Browser would not copy Audio/Video/Docs folders, or all folders from SD to DOK.
- HMI Custom Control: duplicating a control resulted in broken links.
- UAC password: the end user was not able to enter more than 8 characters, even if more were required by the program.
- DNS: Downloading a project including DNS was slow.
- Web server: if the programmer formatted a numeric element in webserver, then edited it in tag database, the numeric format would be corrupted.
- Web Server Element Actions: in some browsers (such as Firefox) if Load Screen was performed before a Set Bit Action, Actions would not run after the screen was loaded.
- Export to Excel: Struct member descriptions were not always exported
- When UniLogic windows were externally docked, mouse wheel + CTRL button did not work.

**UniLogic V1.18.60 UniStream OS 1.18.19 December 2016**

**New Features:**

EtherNet IP: Scanner Node support has doubled, from 16 to 32
OS Update via DOK (USB stick): User is notified by pop-up if DOK is not formatted to FAT32
Maximum size of array was increased from 256 to 512
Message Boxes now support Japanese

USB Keyboard support: plug a keyboard into the UniStream USB port

**Bugs: fixed as of this version**

- EthernetIP: minor connection issues.
- Modbus TCP/IP: minor issues with device ID numbers.
- SMS: in some cases the application only sent messages with index numbers 0 to 9
- DNS server: editing via UniApps did not always take effect until PLC reset
- HMI:
  - Is Active bit turned OFF at language switch
  - Custom Control was not always deleted from HMI Toolbox
  - Minor issues with a read-Only Timer box in a Custom Control
  - Tank element could only by dragging from Toolbox
- Minor fixes in non-UAC Password Management

**UniLogic V1.18.41 UniStream OS 1.18.12 October 2016**

**Bugs: fixed as of this version**

- More efficient handling of animated GIF files and list of images
- EtherNetIP scanner to device communication configuration settings issues in specific cases

**UniLogic V1.18.37 UniStream OS 1.18.9 September 2016**

**Feature List**

<table>
<thead>
<tr>
<th><strong>SQL Connectivity</strong></th>
<th>UniStream supports MS SQL server and can connect to SQL databases.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can use UniLogic to:</td>
</tr>
<tr>
<td></td>
<td>- Access SQL databases via IP address or Hostname</td>
</tr>
<tr>
<td></td>
<td>- Build SQL Queries and execute them via Ladder functions</td>
</tr>
<tr>
<td></td>
<td>- Connect Data Tables to SQL databases and transfer data via Ladder functions</td>
</tr>
</tbody>
</table>

In your Queries, you can use the syntax, commands, and parameters that are supported by the SQL server.
Edit 'Query2' SQL Query:

1: Select top 4 Title, FirstName, LastName
2: from Employees
3: where Title = 'Sales Representative'

<table>
<thead>
<tr>
<th>Name</th>
<th>Query String</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query1</td>
<td>Select top 1 Title, FirstName, L</td>
</tr>
<tr>
<td>Query2</td>
<td>Select top 4 Title, FirstName, L</td>
</tr>
</tbody>
</table>
HMI Screens to Web Page

You can now convert existing HMI Screens to Web Pages via mouse click.

HMI Custom Controls

You can create your own, reusable HMI Custom Controls.

After you create a control, you can drag and drop it from the Solution Explorer, export/import it between projects as .uluce files, or add it to the Library. You can also define tags that are local to a specific Custom Control, these tags will be exported/imported along with the control.
**HMI e mail Configuration Widget**

Use this widget to enable your users to add recipients in the To, Cc, and Bcc fields of an e-mail via the HMI keyboard.

Then, when the application sends an e-mail it will be sent to the addresses the user has entered, in addition to the email addresses already defined for that specific email in the project.

---

**UniApps: Translated Interface**

The UniApps interface has been translated into Russian, Polish, Chinese, (and partially into Czech).

To change the UniApps interface, you simply switch the default language and download your application.

---
UniApps: Edit email Accounts

If you have more than one Account defined in your project, users can select an account and edit the From, Username, and Password parameters, as well as Server settings.

Formula

Now when you create formulas, you select the parameter data types. Then, when you place the formula into your Ladder, the parameters appear as input and output fields—just the same as other Ladder functions.
MODBUS Added Features

MODBUS now brings you new options:

- **UniApps**
  You can now:
  - View a Slave's Alias Name
  - Edit Slave ID of a serial Master
  - Edit IP, Slave IP, and Port in a TCP Master

- **UniLogic**
  You can now export MODBUS Slave data to an Excel file spreadsheet for use with other systems such as SCADA.

UniLogic Advanced Layout

UniLogic brings you highly convenient pin/unpin, undock and float pane options. If you are working with dual monitors, you can even float panes onto different monitor screens. To return the panes, click Layout> Return Layout to Default.
Scenario Measure Length: UID-0808T

The UID-0808T ‘smart I/O’ module now offers a new Scenario: Measure Length. This enables you to measure the length of items on a moving conveyor belt.

A Scenario is a pre-configured implementation of specific functions. A Scenario displays an illustration that shows the exact functions it will carry out, and the I/Os that the functions will use.

HMI Themes

Use Themes to define the appearance of elements as they appear on HMI screens.

Selecting System Theme restores system defaults.
Note that selecting a theme does not change elements already placed on screen.
### Additional Features and Improvements

<table>
<thead>
<tr>
<th>Data Tables</th>
<th>You can now set Min/Max values for columns.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ScreenShot System Operands</strong></td>
<td>The System Struct &gt; Panel Events now contains:</td>
</tr>
<tr>
<td></td>
<td>- A new Screenshot Taken bit. This turns ON when a screenshot is taken. It is reset by the user.</td>
</tr>
<tr>
<td></td>
<td>- A new string: Name of last Screenshot taken. UniStream stores screenshots on the SD card in the path <code>sd/Media/Screenshots</code>.</td>
</tr>
<tr>
<td><strong>Float Precision</strong></td>
<td>User can now view up to 6 numbers after the decimal point.</td>
</tr>
<tr>
<td><strong>New Action: Launch VNC Client</strong></td>
<td>This enables you to load the VNC Client after a power up, or splash screen. This is helpful when using a UniStream as a remote panel for another UniStream controller.</td>
</tr>
</tbody>
</table>

### Bugs: fixed as of this version

This version includes minor bug fixes for several issues.
User Access Control

User Access Control, or UAC, enables you to require users to log via the HMI application. You can then restrict a user's access to:

- HMI elements, including whether an element is visible or enabled.
- UniApps, restricting access to Read-only—or hiding UniApps altogether.

UAC comes with three predefined Groups that are assigned Access Levels. You may add additional Groups according to the requirements of your application. The system allows you to create Access Levels, User Groups, and Users.

Then, when a User logs into the system, UAC can identify that User, the Group to which he belongs and those Access Levels that have been assigned to that Group. UAC then restricts access according to those Access Levels.

New I/O Module: Temperature
Hardware Configuration now includes the UIS-4PTKN.

This new member of the 'Slim' I/O series comprises 4 RTD inputs that support PT1000/NI1000.

**Web Server:**

**Web Data Tables & more**

The Web Server offers new widgets as well as new and improved functionality.

Web Data Table Widget
This allows a user to view, edit, and enter data via web browser.
The form, function, and parameters are similar to the HMI Data Table widget.

Trend Curves: Number Format
You can now display values in hexadecimal, binary, with sign as well as values with decimal points, leading zeros, and more.

Trend Curves: Visibility
A new button in the Web Server Trend widget now allows the viewer to hide and unhide Curves.

**HMI File Selector Browser**

Enable your operator to:
Select files from an SD card or a storage device plugged into a UniStream USB port (DOK, memory stick).

Store the Path and Name of the selected file in a Data Tag.

**HMI Trends: FIFO**

You can now select to display a Trend as Standard or FIFO. When the user views a Standard Trend, the user must stop the sampling, and select the file to view.

If the history contains 15 files, where File_1 is the oldest and the user is currently viewing the active file, clicking the center button will enter History Mode. In History Mode, arrows allow the user to page back to File_14, 13, etc. Within a particular file, the user can use the Slider to navigate back and forth in the file.

**Video Streaming: RTSP URL**

This new feature allows you to provide the RTSP url in the format required by your particular application and device.
The UID-0808THS high-speed module now offers a new Scenario: Measure Length.

This can easily enable you to measure the length of items on a moving conveyor belt.

A Scenario is a pre-configured implementation of specific functions. A Scenario displays an illustration that shows the exact functions it will carry out, and the I/Os that the functions will use.
KNX Configurator

UniStream controllers support a KNX to MODBUS Gateway device, available as GW-KNX1.

Use the KNX Configurator, located under the new Tools tab on the UniLogic ribbon, to create a configuration file.

Download this file to the device in order to set up communications between a UniStream controller and KNX slave devices.

MODBUS Added Features

MODBUS now brings you additional options:

MODBUS Master, Ethernet now supports "Slave ID".

Delay Time (time between messages) can be defined separately for TCP/IP/Serial MODBUS.

Working Mode (Periodic / Aperiodic) can now be configured per Master.

Duplicate Slave – add Slaves quickly by right-clicking a Remote Slave, selecting Duplicate, and then simply editing the required data.
**Additional Features and Improvements**

**Retained Values of Data Tags:**
Retained Data Tag Values can be exported and imported to a .hex file. This file can then be imported or exported via:
- UniLogic, using options on the UniLogic ribbon>PLC tab>Import/ Export.
- UniApps, using a DOK (USB Stick) via Data Management>Memory> Retain Tags Management.

**Import & Export, via PC or UniApps**

**Trend Curve:**
Both HMI and Web Trend Curves now support decimal values.

**Decimal Values**

**HMI Numeric:**
"Real" Decimals
When you use an HMI Numeric Box element and link it to a Real Data type, a new property, Decimal Precision, allows you to set the number of digits after the decimal point.

**VNC**
The maximum number of connections has been increased to 64.

**Screen & Page Background Color**
A new property in both the HMI and Web Page Editors allow you to set a default background color.

**C Functions**
You can now pass a "Data Table: Indexed" as a Function-In parameter to a C-Function.

**Bugs: fixed as of this version**

This version includes fixes for several issues, and additional minor bug fixes.

- Modem was not initialized on UAC-01RS2 or UAC-02RS2 modules
- Retained Timers and Retained Data Tables and other Retained tags with Initial Value did not always re-initialize to the predefined value when "Initialize Retained Tags" was used.
- Retained Timers did not run after PLC was initialize.
- Ethernet/IP - Scanner nodes were limited to 9. If a 10th is added, EIP stopped working

**Minor Fixes**

- Running "Reduce project size" in projects with Alarms sometimes caused an HMI Overload error after download.
- Struct instances comments were not updated when the comments on the struct definition were updated.
- Projects with Modbus, sometimes crashed when UniLogic ran on Windows XP, and very occasionally on Vista/Windows 7 systems
- Order of struct members was sometimes not preserved when importing a UDFB.
- Web Server Live Trend did not support analog inputs and Read-Only tags.
- Compilation error would appear when adding the value -2147483648 to an Int32 tag
- WebServer: the Visibility property did not always function properly in conjunction with the Timer box
- Formula - When adding the element to the ladder Minimize it and then expanding it can cause crash.
- Certain HMI elements were not affected by the Opacity property.
- EtherNet/IP Input Bytes Size: Configuring a scanner with 2 or more adapters, fewer bytes for the first node sometimes resulted in errors
- CanLayer2 RTR Data Response issue: when using response index number -input E- different than 1.
- Copy Byte element did not copy byte 1 in some cases.
**UniLogic 1.16.44 UniStream OS 1.16.9, January 2016**

**New I/O Module:** This new member of the “Wide” I/O series comprises two temperature inputs, 2 analog inputs, 2 analog outputs, and 10 digital inputs, 10 digital pnp outputs including 2 high-speed outputs.

**UIS-WCB2**

**Web Server:** You can now display two types of Trend graphs on an Internet browser.

**Web Trends & mailto:** The Web Server Toolbox now offers:

- **Trend (Data Sampler)**
  This is similar to HMI Trend. It is a graphical representation of a Data Sample.

- **Live Trend**
  Live Trend displays a running variable integer value as a curve on a Trend graph. You may define up to 4 curves.

When the remote viewer accesses Live Trends via, the viewer can click Inspect to display sampling points and hover a cursor over a point to view its value.
Support for mailto:
The Hyperlink Web element now enables you to include mailto: links on your web pages. Remote viewers can click the link to open an addressed email, and include other initial values such as cc, subject, and text for the body of the email.

MODBUS via Serial COM Module/USB ports
You can now use the MODBUS Configurator to run serial MODBUS over both COM Module ports and the UniStream HMI panel’s USB host port. In both cases, you simply need to configure the port by initializing the port for MODBUS.
HMI Trends: View Values + Y-axis

- View Data Values
  Your users can touch the curve and view the sampling value & time while the Trend view is in Stop mode. Touch View Data, then touch the active curve to display two yellow lines that intersect at the touch point. Use the arrows to move the point along the curve.

- Y-axis values
  You can now format these to show decimal values.

Print to pdf

The Tools tab on the UniLogic ribbon now offers Print Project, enabling you to print your Hardware Configuration and Ladder Modules to .pdf.
Data Tables: New DTI Functions + email .csv Attachment

Indexed Data Table functions and features include

- Convert .CSV to UDTF
  use this function to convert a .csv file on an SD card to a .udft (Data Table file) on an SD card.

- UDTF Count
  Returns the number of columns and rows in a DTI Table.

In addition, the function Store DTI to File (SD) now saves both the .csv and .zip file.

You can now send csv files as email attachments.

Indirect Images

The HMI function Fixed Image can now show indirect images hosted on the SD card or DOK.

This enables you, for example, to receive images via communications such as FTP, and to display them on the screen, using the FTP File Receive bit to reload the page.

Alarms - Expanded Features
Alarm Language Localization
The Alarm interface of the Status Viewer and Alarms Summary has been translated into several Languages. Selecting a default language, for example French, translates the interface elements into French.
The languages currently available are French, Czech, Finnish, Polish, and Russian.

Alarm History Widget
This new HMI widget enables the user to view and sort through Alarms that have occurred in the system.

DNS Resolver: Ladder Function
Resolves a server IP address from its host name.

Ethernet/IP
UniStream now supports Explicit Messages in addition to I/O (Implicit) messaging.

Explicit Messaging follows a request/reply (or client/server) format. UniStream supports Explicit Messaging with third-party devices as both Scanner and Adapter.

UniLogic enables you to implement Scanner functionality via Ladder functions.
To support Adapter functionality, you define structs to enable Vendor-specific Objects to access the requested data.

**UID-0808T Advanced Functions: Counters, Immediate Reset + Scenarios**

The UID-0808T module now offers Counters and Scenarios that include Immediate Reset (Hardware) as well as PWM.

A Scenario is a pre-configured implementation of specific functions. A Scenario displays an illustration that shows the exact functions it will carry out, and the I/Os that the functions will use.

When you add a scenario, UniLogic adds fields to the I/O struct that enables you to implement the added functionality in your project.

**FTP: Added Functionality**

New tags in the FTP Server struct indicate when files are received and store the file path.
Power of "C": New Functionality

The C Editor offers two new features:

- **Float (Real) numbers support**
  You can now use Floats in your C functions by using the 'C' Functions in the Float_Macro table. Note that your function must use inputs and outputs of the same data type (float (real) numbers).

- **Ladder Function Reference**
  You can now refer to Ladder functions, by selecting them in the C Editor's Properties Window.

---

Additional Features and Improvements

**VNC**

Two tags have been added to the System>General Struct:

- **VNC Connected (bit)**
  This is ON when VNC is active

- **VNC Number of Connections (UINT32)**
  This contains the number of active connections.

**Stop/Run CPU**

These new options are located on the UniLogic ribbon, under the UniStream Management tab.

**Watch Window**

This now includes a column for Alias name.

**Edit Tag via Right-click**

You can now right-click a tag in the Ladder to open the Tag Editor box.

---

**Bugs: fixed as of this version**

This version includes a fix for a UniCAN communication issue, and additional minor bug fixes.
UniCAN: Keep Alive

As a UniCAN node, UniStream sent UniCAN ‘Alive’ signals while in STOP mode, causing other Unitronics PLCs and Unitronics Remote IO to continue operations as though the node was ‘Alive’ when it was not.

Example: The EX-RC1 application contains logic that resets all outputs if the UniStream node is not ‘Alive’ and running. The UniStream node enters Stop mode, but continues to send “Keep Alive” signals. Therefore, the EX-RC1 does not reset the outputs—even though the UniStream node is, in fact in Stop mode. We strongly recommend upgrading UniStream systems that are communicating with EX-RC1, EXF-RC15, or other Unitronics device via UniCAN.

Minor Fixes

- In certain cases, if the project comprised nameless tags or structs with no members, UniLogic occasionally shut down during compilation.
- Web Server text elements did not support image backgrounds.
- Panel USB Port struct data types were editable; this may have caused errors.
- WebServer radio button: index value of a touch-disabled element could not be changed.
- Web Server Numeric Box, Tanks, and Meters Tooltip would differ from the user_define Tooltip, if Min or Max tags were defined.
- Web Server might at times load page with empty tag values on the initial page load, or when page was refreshed with Ctrl-F5.
- Creating a timer from Tag input and setting it as Retained, rendered the tag un-editable.
- Web Server Numeric Box - if the value of the tag is 0, Leading Zeroes were not shown.
- Tags input description: was not updated when the tag's comment was edited within the tags grid.
- There was no alert if the programmer deleted a Web Page that was referred to by other pages.
- Image Elements message box: using .gif sometimes resulted in an HMI Overload
- Web Server Radio Button Group was showing Index 0 text for all the indexes.
- Data Tables did not work in Online mode if table name contained any of these characters: \/:*?"<>|[]#
  As of this version, UniLogic does not allow tables names to contains one of these characters. Old projects with such table names will be automatically fixed when the project is opened as of this version.
- Adding roles to Web Server did not force these roles to the PLC at download.
- Web Server elements where the same bit was linked to both toggle bit and the property "Touch Enabled", sometimes rendered the toggle inoperative.
- Changing the Retained option of a Data Table tag, did not update the Data table correctly, causing invalid values to display on the HMI.
- Array tags sometimes disappeared when importing tags from Excel.
- VNC Clients names on the HMI did not match the given names on the VNC Clients configuration.
New I/O Modules

Hardware Configuration now supports two newly-released I/O modules:

- 'Wide' I/O series - UISWCB1
  Comprises two temperature inputs, 2 analog inputs, 2 analog outputs, and 10 digital inputs, 10 digital outputs including high-speed.

- 'Standard' I/O series
  UIA-0006, comprising 6 analog outputs.

PWM 'Target'

The USD-0808THS high-speed module now offers a new Block and Scenario option: PWM Target.

You control the position via PWM pulses, while the new tags added to the module's struct, Enable Target, Target, Target Reached, and Current Position, enable you to set the target, monitor the current position, and know when it has been reached.

Write Logic in "C" (Beta)

You can write C functions directly in the UniLogic editor, or copy and paste code into the editor fields.
C functions may be used in the same way as standard ladder functions. You can call them just like standard ladder functions, reuse them, and export/import them via the Library.
Alarms: Expanded features

New Alarm features are a powerful aid to machine builders and automation engineers with applications requiring higher levels of adherence to security standards:

Alarm Sort
A new button on the Alarm Summary and Widget enables the end user to sort the Alarm view according to Severity, Name, Alarm/Group and more.

Alarm Struct
Now, when you create an Alarm, UniLogic creates a Alarm Status struct, including Group State, individual bits to signal Alarm State, whether there are any active alarms in the system and how many are currently active.

Alarm Log
Saving the alarm log from the Alarm Viewer widget now creates a .csv file in addition to the .xml.

Alarm Language Localization
Translate alarm texts, including (display names, comments, descriptions, countermeasures etc) within UniLogic translations grid, or by Export/Import to Excel.

Banner
The user can now change the location of the banner when it is displayed on screen from top to bottom and vice-versa, by pressing the scrolling field, or any area of the banner that is not occupied by a button for more than 2 seconds.

In addition, the Snooze button was moved to a more convenient location, next to the View List button.
Web Server

Web Server now offers new and extended features:

Download file from SD
You can enable a user to download a file from the controller's SD card in two ways:

- Via the Hyperlink Element
- Via Web Page element Actions

Edit Password
The HMI Toolbox now offers the Web Password Management Widget, enabling password management via the HMI screen.

In addition, a new Button Action enables users to change Web passwords via browser.
New Web Elements
You can now display Meters and Tanks on a Web page.

Ladder
This version offers several new Toolbox Elements, as well as new & expanded Features.

File Operation Functions
This new category in the Ladder Toolbox enables you to move and copy Data Table, media and pdf files, Alarm logs, User Logs and screenshots between the SD card and a Disk On Key (DOK or USB stick) in one of the controller's USB ports.

You can also rename and delete SD files.

UDFB: Function In
Structs that are automatically created by UniLogic and I/O structs can now be used as Function In operands for UDFBs.
**Buffer Functions**

These new functions increase the range of buffer operations: Buffer to Struct, Struct to Buffer, and Constant to Buffer.

**Reset Numeric**

This Ladder function now supports array.

---

**Password Protection**

You can now protect Ladder Functions, HMI screens, Data Tables and Recipes.

You can apply or remove 'Batch' protection, which will apply a password to all of the functions or screens within a module, or apply passwords to individual functions and screens. Protected items may be duplicated and may be exported and imported into other applications; the item will appear as locked, and UniLogic will request the password before allowing it to be edited.

---

**SD Browser:**

The SD Browser is improved—and now supports multiple file selection.
### HMI Screenshots

Screenshots can now be renamed and sent as email attachments.

![HMI Screenshots](image1)

### VNC Client

You can now define VNC clients and passwords via PLC Communications>Protocols>VNC Clients.

![VNC Client](image2)

### Additional Features and Improvements

#### SNMP

Now supports up to 448 Agent User Objects.

Note that this change will require existing SNMP agent applications to add .0 to the client application.

#### Faster Project Compilation, Faster Download

This is especially faster in projects comprising Web Server.
Reduced Start-up Time

UniStream start-up time was reduced by 20-25%.

Email Attachments

These now support Screenshots and Alarm Logs.

RTSP Camera

Improved function.

Is Touch Enabled

This feature was added to Static/Binary/List/Range Text/Image elements, along with a Disabled Color property.

I/O Descriptions

You can now edit I/O descriptions.

Bugs: fixed as of this version

This version included minor bug fixes:

- Double right-click on the Elements ToolBox item sometimes elicited a double-click reaction from the element.
- Import from Excel: Schedule, Can Sniffer and Modbus request / descriptor tags could not be deleted after import, unless project is saved and re-opened.
- Web Server port configuration was sometimes not retained.
- Firmware Manager did not show any firmware, if the username on the computer contains non-English characters.
- Trend XY: Selecting a Sampler with only one feed now gives a compilation error.
- Data Sample: the number of Samplers was not shown (was left blank) on the Sampler preview information.
- "Remove unused tags": running this on rare occasions caused UniLogic to crash.
- Web Server: In certain cases projects containing several page modules were used, only compiled one module, sometimes resulting in error 404 or 'Web Server not configured' pages when surfing to the Web Server

Change Summaries for Previous Versions begin on the following page.
Alarms

UniStream’s Alarm system, designed in accordance with ISA ANSI/ISA-18.2-2009 guidelines, provides an efficient method of boosting your application safety level.

Easily accessible from the Solution Explorer, UniLogic provides a broad range of Alarm features, allowing you to configure Alarms to accommodate different application and alarm types.

The Alarm Banner, displayed on your HMI screens, alerts operators, enabling them to open the Alarm Summary list of events, view status, acknowledge and clear Alarms, and read countermeasure instructions.

The Alarm banner may be displayed full-size as shown, with a scrolling window showing active alarms, or may be minimized to a button.

The HMI Toolbox now includes a new widget: the Alarm Status Viewer. This allows convenient Alarms management.

The manager can view Alarm status, enter Comments, Shelve, and Disable Alarms.

Alarm events are logged to the controller’s SD card. You can extract and view these logs via the UniStream Data Converters Suite utility Alarms Log to Excel.

All components of the Alarms system:

Alarm names, alerts, and countermeasure instructions, enjoy multi-language support in all languages including Asian languages.

The components of the Alarm system are a powerful aid to machine builders and automation engineers with applications requiring higher levels of adherence to security standards.
UniLogic Interface Language Support

The UniLogic user interface now supports the following languages: English, French, Chinese, Russian, and Turkish.

Recipes: Populate Data Tables

The new Recipe feature, located on the Solution Explorer, enables you to:

- Create a recipe data file
- Enter the data either directly in UniLogic, or via Excel
- Use the new Ladder function Load DTI from Recipe File to import the data into a DTI Data Table

Note that:

- The data from the Recipe will overwrite any existing data in the DTI
- Recipes and their data are downloaded as part of the UniLogic project into the controller’s flash memory.

SD Browser: New HMI Widget:

The SD Browser widget enables an operator to transfer files from the SD card in the UniStream panel to a storage device (DOK, memory stick) plugged into a UniStream USB port, from the user application. Formerly, this could only (and can still) be done via UniApps.
HMI Screenshots: Improve Load Time

Two new buttons, “Take screenshot” and “Select All Dynamic Elements” were added to the UniLogic HMI editor ribbon.

To use these features to improve screen load times:

- Design your screen, placing the HMI elements as desired.
- Click the Screenshot button to save the screen as a single graphic image.
- Click Select All Dynamic Elements, and press Ctrl +C, to copy all of the variable elements on the page.
- Import the saved single image screenshot as the background image of a new screen.
- Press Ctrl +V to paste the dynamic elements onto the page.

This allows the page to load a single image (the screenshot) instead of many images, thereby improving load times.

The Screenshot feature is also handy for documenting your end user application.
New PC Utilities Suite

Use our new convenient UniStream Data Converters Suite to perform quick and easy data conversions:

- UniStream and Vision Trend files to PDF
- UniStream Data Table files to Excel
- Excel file to a UniStream Data Table file
- UniStream Trend file (Data Sampler) file to Excel
- UniStream Alarm log to an Excel

You can download the UniStream Data Converters Suite from the Unitronics website: http://www.unitronics.com/support/downloads.

UniLogic Improvement Program

When you install this and future versions, the Installation program will ask you to join the UniLogic Programmer Experience Improvement Program.

The program is intended to help Unitronics understand and anticipate the needs of the programmer.

When you participate, we collect basic, anonymous information about the UniLogic and UniStream features you use. These reports are sent to Unitronics and can help us to improve the features our customers use most often, determine feature development goals, improve the overall user experience, and create solutions to common problems.

Participation is voluntary, and you may opt out at any time via the UniLogic Help menu. No personal information or source code is collected. Unitronics is committed to helping protect your privacy. Our privacy policy statement explains the data collection and use practices for the UniLogic Programmer Experience Improvement Program reports that will be sent to Unitronics if you participate in the program.

Our privacy policy may be viewed at:

Ethernet/IP Improvements

This version also included a number of improvements to the Ethernet/IP features:

- The number of supported Ethernet/IP nodes was increased to 16.
- The minimum RPI (Requested Packet Interval) was decreased to 4ms.
- The buffer size was increased to a maximum of 496 bytes.
Additional Features and Improvements

**Virtual Keyboard**  Buttons sensitivity was fine-tuned, reducing the possibility of false entries

**Play Sound Action**  "Play repeatedly" option was added under Play Sound in the Global Actions.

**Tags, Online**  Tag format (Hex, Dec, etc.) can now be changed during Online mode, within the Tags Grid

**Search -Ladder**  Right-click menu now allows you to search for Ladder Elements in the Ladder Toolbox

---

**Note regarding UniLogic 1.14.33**

The release of version, **1.14.44** includes a French language file update for the UniLogic Interface Language feature, an improvement from version **1.14.33**.

---

**Bugs: fixed as of this version**

This version included minor bug fixes:

- Double right-click on the Elements ToolBox item sometimes elicited a double-click reaction from the element.
- Import from Excel: Schedule, Can Sniffer and Modbus request / descriptor tags could not be deleted after import, unless project is saved and re-opened.
- Web Server port configuration was sometimes not retained.
- Firmware Manager did not show any firmware, if the username on the computer contains non-English characters.
- Trend XY: Selecting a Sampler with only one feed now gives a compilation error.
- Data Sample: the number of Samplers was not shown (was left blank) on the Sampler preview information.
- "Remove unused tags": running this on rare occasions caused UniLogic to crash.
- Web Server: In certain cases projects containing several page modules were used, only compiled one module, sometimes resulting in error 404 or 'Web Server not configured' pages when surfing to the Web Server

---

**UniLogic 1.13.9 UniStream OS 1.13.5, March, 2015**

UNILOGIC 1.13.9 UNISTREAM OS 1.13.5
EtherNet/IP™

UniLogic enables you to easily set up and exchange data with remote devices via EtherNet/IP. You set up EtherNet/IP communications by entering parameters into a simple configuration grid. No ladder programming is required.

A single UniStream controller can function as both an:

- EtherNet/IP I/O Scanner (Master)
- EtherNet/IP I/O Adapter (Slave)

A single controller can contain multiple node definitions for both Scanner and Adapter.

You simply define the data tags that the UniStream controller will use to exchange data during an EtherNet/IP session, and a time interval (RPI) that determines the data exchange rate.

Explicit Messages

UniStream does not currently support explicit messaging. This functionality will be supported in a future version.
Multiple UniLogic version support

UniLogic now enables you to keep the current UniLogic version when upgrading to a new one. Keeping the previous version enables you to use older UniLogic versions to use with older projects.

Starting from this version, when upgrading the UniLogic version, you can select 'Keep a copy of the old version' as shown below.

At the end of the installation process, shortcuts will be placed on your desktop:
- "Unitronics UniLogic" links to the newly installed version
- "Unitronics UniLogic 1.12.20.0 (or whatever your previous version may be) links to the previous version.

The oldest UniLogic version that supports this feature is 1.12.20.
**UID-0808THS module:** The UID-0808THS module offers a new configuration: Counter and Scenario 3. This scenario enables you to use the changing state of the high-speed counter to trigger the scenario. Use the counter value to control the output state by determining:

- The initial number of pulses required to activate the output.
- The number of pulses that must elapse before the output is deactivated.
- The number of pulses that must pass until the cycle repeats.

**Panel ‘Mirroring’ via VNC** You can now use a UniStream panel that is not installed with a CPU to function as a mirror, showing the HMI displays of a remotely located UniStream controller.
Simply open VNC Client on the ‘mirroring’ panel and enter the connection settings of a remote panel + CPU. Next, under CPU Control, select Ignore CPU events.

This enables the panel that is not connected to a CPU to function as a VNC client, and prevents the display of CPU messages.

New System Tags System tags (read-only) are now provided for CPU IP address and Panel address in the System>General struct.

Bugs: fixed as of this version

- This version included a few minor bug fixes.


Features

Hardware Configuration

UIA-0800N This new Uni-I/O™ analog module comprises 8 13-bit analog input channels. The supported input ranges are 0-10v, 0-20mA and 4-20mA.
New 3G Modem Support

A new 3G modem, the Cinterion EHS6T, is now supported by UniStream. The modem can be selected from the Modems menu in the Solution Explorer.

I/O ‘configs’

'Configs' enable a controller to run the application if it has a physical I/O configuration that is different from the full I/O Configuration in the project.

Configs are Hardware Configuration profiles that are downloaded into the controller with the project. Via UniApps, the end-user selects the Config that matches the actual modules that are snapped onto the controller, or that are connected via short-or-long-range I/O expansion kits.

The application will run according to the selected Config without error—even if the application uses data tags of I/Os that belong full I/O configuration, but that are not part of selected Config.
The UID-0808THS module offers a new configuration: Counter and Scenario 2. This scenario enables the user to use the HS counter as the deactivation trigger for the scenario.

Communications

HMI Video Widget: Video Streaming

You can now stream video from a network camera (Ethernet) that supports the RTSP (Real Time Streaming Protocol) and the video formats listed below. This allows you to easily integrate a network camera and display its video stream output on the UniStream panel.

Supported video format is MPEG-4 Visual, part 2, AVC/H.264.
**SNMPv1/v2/v3**  
UniStream can now function as an SNMP (Simple Network Management Protocol) Agent and communicate with an SNMP server.

In addition, the Ladder Toolbox function SNMP Trap Send, enables UniStream to send SNMP Trap messages to an SNMP server. UniStream supports SNMP Versions 1, 2, and 3; the programmer can select which version of the protocol to use.

![SNMP Configuration screenshot](image)

**VNC: New Password Levels**  
A View Only access level was added to the VNC feature. The programmer can now set password protection for two VNC access levels, Full Access or View Only and thus guarantee two classes of access rights.

![VNC Full Access and View Only](image)

**WebServer Gauges**  
The Webserver editor now supports the same beautifully polished Linear and Circular gauge widgets offered by the HMI editor. This enables a remote user to watch running application values via an Internet browser, as if they were viewing the gauges on the HMI panel display.

![WebServer Gauges](image)
New COM Ladder Functions

Ping a remote device via Ladder.

Use the new Ladder function TCP Server Disconnect.

Additional Features and Improvements

Force I/O

You can now access and force I/O status.

- Via UniApps > Memory > Tags > I/O Tags, selecting the I/O module, and selecting Inputs or Outputs.

- Via OnLine Test Mode.
HMI: Message Box

HMI Elements that offer Actions now have a new property, Message Box.

This enables you to create a popup message that opens when the user touches the element.

The message can ask the user a question, or give instructions and warnings.

You can select icons, include buttons in the Message Box and use them to drive actions.
Screenshots
Invoking UniApps now raises a popup menu that offers you the option of entering UniApps or taking a Screenshot, which is automatically stored on the SD card.

The popup menu also opens when switching from UniApps back to the user application.

Trend graphs now have an icon that the user can press to take a screenshot of a Trend.

Data Tables
Images for Binary Values
You can now use images to represent binary values, even if the binary tag is part of an array.
Format Display Values  You can now select different formats to display values. When the user edits values via the panel, the selected format will be represented in the range shown on the keyboard.

Download  The following no longer require the PLC to reset at download:

- MODBUS – Adding or editing MODBUS to an application
- Downloading Data Tables
- Editing Operands

HMI Selection Wheel  The scrolling sensitivity of the selection wheel has been improved and new scroll buttons aid in fine tuning. In addition, the wheel will now open to display the last selected value (not the first value in the list).

Installation Note  OS version 1.12.7 requires applications written with UniLogic 1.12.20 or higher. If you have installed OS 1.12.7 BIN files and receive a message stating Invalid User Application, either:

- Download a blank application written with UniLogic 1.12.20
- Update your existing application by opening it with UniLogic 1.12.20, and then downloading it

Bugs: fixed as of this version

- Find value in DT
- Insert string to string
- Excel, Export Operands: if a struct name contained illegal characters, [ ] : \ / ? and/or exceeded 31 characters length, export failed. UniLogic no longer allows the creation of struct names that are not supported by Excel.
• HMI Variable, Password Box: when an end-user entered characters and then returned to the password field, the characters could be viewed.

• Export/Import Ladder/HMI Module to Library: in certain cases, import was not successful.

• Data Tables
  - At Download, operand values would be initialized.
  - Export/Import from Excel: If a table was exported with values, edited in Excel and then imported, the new values were not preserved, but were overwritten by the values that existed in the table at export.

UniLogic 1.8.51, UniStream OS 1.8.9, October 2014

Features

Hardware Configuration

USP-156-B10: 15.6” HMI panel

This quality HMI panel measures 15.6”.

In terms of I/O and COM module capacity, it is identical to the UniStream 10.4”.

UID-W1616R

The UID-W1616R offers 16 pnp/npn inputs, and 16 relay outputs.

Uni-I/O™ Wide

All I/Os are isolated.

This is the first member of the Uni-I/O™ Wide family, a new line of I/O modules that are compatible with the UniStream™ control platform. ‘Wide’ modules are 1.5 times as wide as standard Uni-I/O™ modules, and comprise more I/O points in less space.
Up to two wide I/Os may be snapped onto the back of the UniStream 7”.

Standard-sized I/Os and Wide I/Os may all be included in a single configuration.

**New Temperature I/O Module**

UIS-08TC is a standard-sized Uni-I/O™ module. It provides 8 thermocouple inputs supporting the following input types and ranges: J, K, T, E, R, S, B, N, C, and Voltage.

**Communications**

**Embedded Web Server + Web Page Editor**

The powerful, built-in Web Server enables multiple users to simultaneously access webpages within a UniStream controller. Web page access may be controlled by password, permitting users to view and/or edit data via any browser and from any smart phone or tablet.
Designing web pages in the editor is as easy as building HMI pages, and requires no knowledge of HTML. The programmer drags and drops elements from the Toolbox onto the web page, and customizes them via the element properties.

The drag & drop interface has the same look-and-feel as the HMI Editor.

**CAN Layer 2 Ladder Functions**

The CAN Layer 2 functions enable you to support any CANbus protocol, according to the CANbus V2.0 standard.

A UniStream controller can both send and receive standard messages with 11-bit identifiers, as well as extended messages with 29-bit identifiers.
UniCAN

UniCAN, Unitronics' proprietary CANbus protocol, enables fast data communications.

Via UniCAN, a Unitronics' PLC can exchange data with up to 60 other networked PLCs.

UniCAN Communications are determined by configuration rather than programming.

UniCAN also enables easy data transfer between UniStream and Vision controllers.

CANbus Sniffer

The embedded CANbus Sniffer enables you to easily monitor CANbus communications and boosts your troubleshooting capabilities.

UniBACnet Configurator

UniStream controllers now support a BACnet to MODBUS Gateway device, available as GW-BAC1.

Use the UniBACnet Configurator, located under the new Tools tab on the UniLogic ribbon, to create a configuration file for the BACnet to MODBUS Gateway. Download this file to the GW-BAC1 in order to set up communications between a UniStream controller and BACnet slave devices.
Additional New Features

Keyboard Features

- Scaling: Touching the magnifying glass adjusts the size of the keyboard
- Keyboard Title
  This new HMI property is now included in HMI elements that allow data entry, enables the programmer to customize the title bar of the virtual keyboard

Data Tags

Grid editing: click directly in the Tag table and enter values.

Data Tables

You can now set the display format for Int32, UInt, and Timer by right-clicking and making a selection.

Improvements

Improved Language Switching: No need for HMI restart.

UniApps, Display & Audio:

- Improved Display Brightness Range: 0 - 100
- Decreased loading time

Bugs: fixed as of this version

Trends:

- Trend Run Button was not always refreshed when Sampling was turned on and off following file deletion
- Rapidly switching Trend pages sometimes caused an HMI crash
HMI Elements:
- IP Address:
  - was not initialized with its linked string operand power-up value
  - did not always reset the value of the attached IP tag
- List: A 'Selection Changed' bit of List element was set at each screen reload, if the selected index was different than '0'
- Numeric Box: Hex values were shown in lower-case on the display, but in upper-case on the editing keyboard

UniApps
- Calculator: The numerals entered could exceed the calculator's field
- Operands: the Back button returned to the first page instead of the previous page.

Data Tables
- Multiple and/or heavy Data Tables were not always displayed correctly
- No part of a Data Table name was shown if the DT was not wide enough
- Rapid scrolling through Data Tables sometimes caused an HMI crash
Features

**Video Player**  Use the HMI Video Player widget to play MPEG-4 video files on the HMI screen (MPEG-4 Visual, part 2, AVC/H.264).

The widget properties enable you to display video controls that enable the user to start, stop, and adjust the volume.

You can set the video to autoplay, and play it in a loop.

Note that the video is not visible via VNC.

**.pdf Viewer**  This new HMI widget enables you to display a .pdf, and allow the user to page through it and adjust the Zoom level.
New Gauges

Use the Gauge widgets to display a variable value. Gauges are available in different shapes and styles. Use the gauge properties to customize the values and appearance of the gauge.

Import/Export
I/O tags to Excel

You can now export I/O Data Tags into Excel, edit them, and then import them back into UniLogic via Import Export on the PLC ribbon.

Find & Replace Tags

The Find (Ctrl + F) and Find & Replace (Ctrl + H) utilities on the Edit tab enable you to quickly find and replace any tags that in your project.
**New Trend Widget:** In addition to the standard Trend graph widget, where the X axis is time, you can create a graph using the XY Trend widget. This enables you to define units such as millibar or degrees for the X axis.

**Data Table Widget** You can now adjust the Column width of Data Tables, either by entering a value or manually adjusting them.
Create File, Insert  After building a message, you can append it to a file it via the Append Buffer to File Function. This enables you to create .csv, .txt, and .bin. files.

You can use .txt files as the body of an email.

High-Speed Counter Reset  The high-speed I/O module struct, UID-0808THS, now offers a Reset Counter bit that you can use in your program to initialize the counter value.

New I/P-Timer Keypad  The new keypad is attractively divided into fields. Navigate between the fields via arrows.
Support for EXF-RC15

The EXF-RC15 is a stand-alone high-speed Remote I/O Module. It offers 9 digital inputs, 4 digital transistor outputs, and 2 relay outputs. Three inputs can be set via wiring and software to function as high-speed counters/Shaft-Encoders. The four transistor outputs may function as high-speed PWM/PTO outputs.

You can include the EXF-RC15 by using files that are ported between VisiLogic and UniLogic.

Bug Fixes

Numeric Box HMI element: Certain issues with the decimal point placement have been fixed.

UniLogic 1.6.66, UniStream OS 1.6.13, April 2014

Hardware Configuration

<table>
<thead>
<tr>
<th>New Temperature I/O Module</th>
<th>UIS-04PTN provides 4 RTD inputs supporting PT100, NI100, NI120, and Resistance.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Long-Range Local Expansion Adapters</td>
<td>UAG-XKPLxxx: New Long Range Local Expansion adapter. (Available with 6 or 12 meter [20 or 40 feet] cable)</td>
</tr>
</tbody>
</table>
You can use Short or Long Range Local Expansion Adapters to connect a UniStream™ controller to a row of I/O modules located on a DIN-rail. Daisy-chain up to 5 Local I/O Expansion Adapters to one controller to further increase the number of I/O modules up to 85.

Additional Features

New Languages

This version supports 10 new languages: Ukrainian, Romanian, Hungarian, Georgian, Slovenian, Slovak, Serbian, Latvian, Lithuanian, Estonian, Filipino and Swedish.

In addition, you can edit Language strings directly in the Language table.
You can also export a Language file, translate or edit it in Excel, and then import it back into the project.

**Data Tables: Direct Edit**

Within UniLogic, you can now click on a Data Table cell to directly enter or edit values.
This version also supports Export and Import from Excel

HMI Screen Jumps

- You can select whether to Show Hourglass in a Screen's Properties to display an hourglass during screen transitions.
- Displays now load faster.
**Firmware Management**

When you download a project, UniLogic now checks to see if the firmware in the controller is compatible with the UniLogic version.

In addition, the PLC tab on the program ribbon offers Firmware Management tools:

- The Firmware Manager which locates all firmware files on your PC.
- Update Firmware, which connects to the Unitronics website and downloads any new firmware releases.

---

**Ethernet Favorites**

When you select Ethernet PC-PLC Communications, you can use IP Favorites. This is a global file that is available in all of your UniLogic projects.
### New HMI Editor features

This version supports a number of new features:

- Apply Layout: Select multiple HMI elements of the same type/list of text/range, and then right-click to apply font, font alignment, and other attributes.
- Copy & Paste of object now retains the object’s location.
- Changing font properties causes all future elements to use the new setting.
- Duplicate Screens via right-click on the screen in Solution Explorer.

### Actions: Sounds

Actions now offer a System Sound Library.

![System Sound Library](image)

### Keep last Communication method

When you establish PC-PLC communications, UniLogic will continue to use the last communication channel you used, whether via Ethernet or USB, for as long as that channel is valid. You can change the channel by selecting Communications from the PLC tab on the ribbon.

### New Ladder Functions

This version includes a number of new Ladder functions:

- Reset Numeric
- Set Date/Time from Ladder
- Copy Byte
- String compare 8-16-32
- Find and replace in array/buffer
- Swap: 16/32 bit tags
- Swap Array/Buffer
Indexed Data Tables (DTIs) offer new Ladder functions:

- **Find Value in DTI Column**
  Finds a value in a column and writes the row index number into a data tag.

- **Copy Array to Column in DTI**
  Copies an array, or part of an array, into a specified column in a Data Table column.

- **Copy DTI Column into Array**
  Copies data from a Data Table column into an array.

- **Copy Column to Column in DTI**
  Reads data from one DTI column and writes it into another column. The columns may be in different Data Tables.

- **Write value to DTI Column**
  Writes values into a column in a DTI. You can use it to initialize a column.

- **Find Values in DTI Row**
  Searches a range of rows for data that matches the current contents of a struct.

In addition, you can find all locations where a Data Table is referenced by right-clicking the Data Table in the Solution Explorer.

**Toggle Online Test Mode**

Press F9 to toggle OnLine Mode on and off.
**State Machine**  This button enables you to use the value of a register to display variable text within a button, and to drive multiple Actions via the button.

**Keyboard on Screen**  A new system tag, Keyboard Bit is ON when the keyboard is displayed on the UniStream Panel. Keyboard Bit is located in the System> General> struct

**Top of Region**  A new icon enables you to jump to the top of the region you are editing.
As of this version, project media Audio files will download to SD card. Note that in older projects, audio was stored in Flash memory. When these projects are edited in this version and up, any previous audio files will continue to be stored in Flash; however any added audio files will download to SD card.

**Initial Values at Download**

When you check Retain, you have the option of entering an Initial Value. If you:

- Enter a value, that value will be downloaded with the application **first time** the tag is downloaded to the PLC.
- Do not enter a value; the tag value will be initialized to 0 **first time** the tag is downloaded to the PLC.

Note that if you change a tag’s Data Type, the tag will be initialized to 0 at download.

---

You can use the members of the struct of COM Modules, the CPU RS485 port or the struct of the USB port (set to Serial Communications) to monitor incoming strings for terminators such as length, silence, and ETX characters.
Known Issue

Only one .gif may be placed on a screen. If there is more than one, UniLogic will display a compilation error.

UniLogic 1.5 Rev 3, UniStream OS 1.5.0, February 2014

Timer Preset Value Retained
Starting from this version, modified Timer Preset Values are retained whether they are edited via HMI entry or Ladder code.

Ladder Coil Element Modified
When viewing Ladder code at certain resolutions, some users had trouble differentiating the Contact elements from the Coil elements. The Coil element has been modified to make the difference clearer.

MODBUS Slave Action Text
Previously, the options were Read and Write. The options are now Read Only and Read/Write. Note that the actual functionality is unchanged, only the text has been modified.

Hardware Configuration - High-speed Counter Block: Capture Counter
When you configure a High-speed block, setting the High-Speed Type to Counter And Scenario 1 shows a new property, Capture Counter. Use this to record the value of the high-speed counter in the other Block into a data tag in the I/O module’s struct called Caught Counter Value.

This means that activating:

- Capture Counter in Block 1 will record the counter value in Block 2 into the tag B1-SC1: Caught Counter Value, as shown in the next image.
- Capture Counter in Block 2 will record the counter value in Block 1 into the tag B2-SC2: Caught Counter Value.
Bug Fixes: Fixed in the Current Version
COM Module UAC-02-RS2, Modem
In certain cases, the Modem port setting did not work.

UniLogic 1.4 Rev 3, UniStream OS 1.4, Rev 1, January 2014

HMI Element Numeric Box: New Features

- Text After
- Timer Format
- Number of Digits to Display
- Leading Zeros
- Convenient Special Characters for Text After
**HMI Timer Box Widget**

Time and Date widgets now include Timer.

**Schedule Widgets**

Use the HMI schedule widgets to display Schedule times from the Schedule struct. You can also enable a user to enter Hour time data.

**Data Tables: HMI Widget Editing Mode**

Four new parameters enable you to:

- Highlight the selected row
- Record the column and row of the current selection
- Record which array member is currently selected
Remove Unused Tags
Click this on the PLC tab to remove unused Global and Timer tags.

Passwords: View Typed Characters
You can reveal the just-typed characters in:
- UniLogic Password Manager, by clicking the ‘eye’ icon.
- In UniApps, by touching the ‘Eye’ icon.

UniApps: Improved SD Browser Interface
The browser now offers a slider and colors for easier navigation.
Save as XP
Use this option if you have written your project on a PC running Windows 7, but want to ensure that it can be edited on a PC running Windows XP.
This services the Known Issue Windows Versions and UniLogic Project Issues documented in the previous version, UniLogic 1.2.5.

Bug Fixes

Turkish Regional Setting
When Format settings (typically Control Panel> Clock, Language, and Region> Region and Language> Format) were set to Turkish (Turkey Format), certain actions such as Delete or Copy caused the program to close.

Struct/Array Editing Issue
When the user created a Struct or Array, edited the entity name, and then saved the project, the struct or array would not load or compile correctly.

UniLogic 1.2.5, UniStream OS 1.2.2 December, 2013

Chinese Support
HMI Text Elements now support Chinese characters.

Download without Reset
Certain program changes will no longer require reset after download.

Mouse: Plug-and-play
Plug a mouse into a panel USB port to operate the screen via mouse.

Formula
Use Formula to build mathematical expressions, save them, and use them throughout your program.

New HMI Element: Password Widget
You can insert a Password HMI widget that requires operators to enter a password via the controller's keyboard. When the user touches it, the virtual keypad appears, enabling the user to enter the password. Via HMI Actions, you can drive a number of tasks according to the result.

FTP Client/Server
Configure a UniStream controller as FTP Server and/or Client. Use the Ladder elements COM>FTP to receive and send files.

VNC Client: New HMI Action
Enable UniStream controllers to access other UniStream controllers. Use the HMI action Load VNC Connection to display another UniStream controller screen on its screen.
**New Touch Events System Operands**

“Touched Bit” is ON while the touch screen is actually being touched.

**High-Speed I/Os: Embedded Scenarios**

New scenarios make it easy to select the appropriate configuration for your application.

**Simplified OS update from UniLogic**

From this version on, UniLogic diagnoses when the UniStream OS is outdated. UniLogic then prompts you to plug a USB stick into your PC to download an updated OS, which you can then install into the controller.
Update from the Web
The Help tab contains new options for updating BIN and Help files.

Ladder/HMI Library—Reuse your work
UniLogic now includes a global library that is accessible from the Solution Explorer. Any Ladder Function and HMI Screen you place here will be available for use in all UniLogic projects.

MODBUS via Ladder Utility
By default, MODBUS is set to run operations periodically. You can now run operations according to Ladder function, using the Ladder element MODBUS Aperiodic (Ladder Triggered).

RS485 via Panel or via the CPU
You can configure the serial port on the CPU:
- To run MODBUS, via the panel.
- To run Serial communications for serial devices via the CPU.

VNC Server: supports multi clients
VNC server now supports multiple clients, such as smartphones.

UniApps Download Signature History
View the download history by accessing UniApps>System>About > UniLogic Apps tab.

Remote I/Os: Now supports up to 8 adapters
UniStream can now support up to 8 to 8 EX-RC1 expansion adaptors; each adaptor can support up to 8 I/O modules.

UniPics: Expanded Library
UniStream’s free graphic library has a number of new images.

Export/Import Module
Right-click on a Ladder Module and select import or export it with all functions, or an HMI module to import or export it with all of its screens.

Bug Fixes
Display Initial Values for Display
When entering an HMI screen, there was a short delay before the Image elements refreshed to show the actual state.

Export/Import
Issues relating to tags have been fixed.

Known Issues
Windows Versions and UniLogic Project Issues
The UniLogic installation uses different databases:
- Windows XP uses SQL 2008
- Window 7 and up use an internal database.
This causes issues when porting complete UniLogic projects, individual Ladder functions (UDFBs), and HMI screens:

- Opening a project that was written in Windows 7 (or later) in Windows XP will cause UniLogic to shut down.
- Trying to upload a project into XP that was downloaded using Windows 7 (or later)
- Importing Ladder functions and HMI screens that were written in Windows 7 (or later) in Windows XP will cause UniLogic to shut down.